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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.

Warranty
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Corporate Profile

CORPORATE PROFILE
Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size and shape, intrusion porosimetry, powder rheology, and
activity testing of catalysts. The company has R&D and manufacturing sites in the USA, UK, and
Spain, and direct sales and service operations throughout the Americas, Europe, and Asia.
Micromeritics systems are the instruments-of-choice in more than 10,000 laboratories of the
world’s most innovative companies, prestigious government, and academic institutions. Our
world-class scientists and responsive support teams enable customer success by applying
Micromeritics technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International — contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Learning Center
Phone: 1-770-662-3607
www.Micro.edu

Contact Us
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About this Manual

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.Micromeritics.com).

n Calculations document (PDF)
n Error Messages document (PDF)
n Parts and Accessories

n Smart VacPrep Operator Manual
(PDF)

n Vacuum Pump Guide (PDF)

All references to Gemini VII in this document encompass the Gemini VII models
2390a, 2390p, and 2390t unless otherwise noted. It also encompasses all references
to the Gemini VII and Gemini VII Confirm environments unless otherwise noted.

This manual contains instructions for installations in standard and 21CFR11
environments. For instructions on installing the software in a 21CFR11 environment,
see the Confirm Administrator Guide [part number 004-42821-01].

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage
the analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.

NOTE — Notes that apply to 21CFR11 environments only (Confirm applications).
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GENERAL SAFETY

Do not modify this instrument without the authorization of a Micromeritics service per-
sonnel.

Toxic or flammable gases require proper venting of exhaust.

Any piece of laboratory equipment can become dangerous to personnel when improperly
operated or poorly maintained. All employees operating and maintaining Micromeritics
instruments should be familiar with its operation and should be thoroughly trained and instructed
on safety.

n Read the operator manual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Wear the appropriate personal protective equipment when operating this instru-
ment — such as eye protection, lab coat, protective gloves, etc.

n When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The Gemini 2390 weighs approximately 32 kg (75 lb).

n Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not become worn or damaged.

n The Gemini VII sound level is below 80 dBA. Hearing protection is optional.
n The Gemini VII has a safety shield. Ensure it is in place when operating the instru-

ment.
n Proper maintenance is critical to personnel safety and smooth instrument oper-

ation and performance. Instruments require regular maintenance to help promote
safety, provide an optimum end test result, and to prevent costly down time. Failure
to practice proper maintenance procedures can lead to unsafe conditions and
shorten the life of the instrument.

n Improper handling, disposing of, or transporting potentially hazardous materials
can cause serious bodily harm or damage the instrument. Always refer to the
MSDS when handling hazardous materials. Safe operation and handling of the
instrument, supplies, and accessories is the responsibility of the operator.

General Safety
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General Safety

INTENDED USE
The Gemini VII series analyzers provide single and multipoint surface area and pore size
measurements. Three models are available — the Gemini 2390a, 2390p, and 2390t.

The Gemini 2390a and 2390p are enclosed in the same size cabinet. The only physical difference
is the P0 (saturation pressure) tube which is installed on the Gemini 2390p, allowing continuous
measurement of the saturation pressure.

The Gemini 2390t is in a slightly larger cabinet allowing the use of a larger dewar and longer
sample tubes for extended analyses. This model also is equipped with a P0 tube.

Most application features are available on all three models, with the exception of a continuous P0
measurement and a few reports.

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer as well as
relevant hazards involved and prevention methods. All use, other than that described
in this manual, is seen as unintended use and can cause a safety hazard.

The instrument is intended to be used as per applicable local and national regulations.
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TRAINING
It is the responsibility of the customer to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.

ENVIRONMENTALLY FRIENDLY USE PERIOD

Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Cover x o o o o o

Power
Supplies x o o o o o

Printed
Circuit
Boards

x o o o o o

Cables, Con-
nectors &
Transducers

x o o o o o

Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here, unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and so
are marked to reflect such. The Environmentally Friendly Use Period is valid
only when the product is operated under the conditions defined in the product
manual.

General Safety
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1 ANALYZER COMPONENTS
Parts and accessories can be found online at www.Micromeritics.com.

FRONT COMPONENTS

A. Dewar
B. Sample safety shield
C. Power indicator light
D. Balance port and balance tube
E. P0 port and tube
F. Sample port and sample tube
G. Tube position diagram
H. Elevator

Components Description
Dewar For housing cryogens used for analysis. The Dewar rests on an

elevator.
Sample safety shield Closes to cover the Dewar.

Power indicator light Blinks when power is applied to the analyzer; illuminates when
the analysis program is initiated and ready for operation.

Balance port and balance
tube

The balance tube is identical to the sample tube. This design
negates free-space errors introduced by thermal gradient vari-
ations or by initial mis-measurement of free space.

P0 port and tube Models 2390p and 2390t only. For measuring the saturation
pressure.

Front Components

1 Analyzer Components
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1 Analyzer Components

Components Description
Sample port and sample
tube

Holds the material to be analyzed.

Tube position diagram Diagram of the positions of the balance and sample tubes. The
empty tube represents the balance tube installed on the left port.
The filled tube represents the sample tube installed on the right
port.

Elevator Allows placement of the Dewar around the sample and P0
tubes. The elevator is raised automatically when the analysis is
started and lowers automatically upon completion.

Front Components (continued)

BACK PANEL COMPONENTS

A. Power connector
B. Power switch
C. RS232 connector - for service personnel use
D. USB ports - not used
E. Ethernet port
F. Keypad connection - used only wit keypad con-

figurations
G. Helium inlet port for helium gas supply
H. Adsorptive gas inlet
I. Vacuum pump connector
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EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories can be found online at www.Micromeritics.com.

Option Description
Chiller Dewar For Gemini model 2390t.

A closed loop recirculating system that utilizes a high surface area
copper coil to provide excellent heat transfer between the Dewar and
the recirculating liquids. The Chiller Dewar Quick Start Guide [part
number 025-42801-00] can be found on the Micromeritics web page
(www.Micromeritics.com).

Vacuum Pump The analyzer requires a vacuum pump for sample analysis. Vacuum
pumps used must meet the following criteria:

n Achieve vacuum levels of 20 μmHg at the analyzer inlet
n Contain an anti-suckback valve to prevent vacuum pump oil from

back streaming into the analyzer in the event of a vacuum pump
failure

n Contain an NW16 inlet port for connection to the analyzer

A device to reduce oil vapor backstreaming is recom-
mended.

The vacuum pump must have an anti-suckback valve to
prevent oil from being admitted into the analyzer should
the power fail while the system is under vacuum. Pumps
available from Micromeritics are equipped with an anti-
suckback valve.

An oil-based or oil-free vacuum pump can be used with the analyzer.
Appropriate vacuum pumps are available from Micromeritics.

Equipment Options and Upgrades
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1 Analyzer Components

Degasser Options Description
FlowPrep The FlowPrep applies both heat and a stream of inert gas to the

sample to remove adsorbed contaminants from the surface and pores
in preparation for analysis for up to six samples. Choose the tem-
perature, gas, and flow rate best suited for your sample material. The
FlowPrep is an independent unit and not controlled by the analyzer.

Smart VacPrep The Smart VacPrep prepares samples by heating and evacuation. It
contains six sample ports in which up to five temperatures, ramp
rates, and soak times per sample are individually controlled by the
analyzer program so that all degas information is integrated into the
sample data file for future reference. Samples can also be prepared,
started, and completed independently. There is no need to wait for
samples on other ports to finish. Front panel buttons allow a
QuickStart operation with preprogrammed conditions.

Up to three additional Smart VacPrep degassers can be connected to
one computer permitting 24 preparation ports to be used. The Smart
VacPrep is the recommended degassing unit.

VacPrep The VacPrep offers two methods for removing contaminants. In addi-
tion to flowing gas, it provides vacuum to prepare samples by heating
and evacuation of up to six samples. This combination provides pre-
paration method options best suited to your material or application.
Needle valves are also provided for introducing the vacuum slowly to
prevent fluidization of samples. The VacPrep is an independent unit
and not controlled by the analyzer.
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GAS REQUIREMENTS AND PURITY

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are
required. Pressure relief valves should be set to no more than 30 psig (200 kPag). All gases
should be of a purity listed below. Gas regulators can be ordered from Micromeritics. Parts and
accessories can be found online at www.Micromeritics.com.

When helium is used for differential free-space measurement and nitrogen is used as the
adsorbate gas, they should be of the following purity or better:

n Helium— purity of 99.9%. For analysis of materials with very low surface areas, Micromeritics
recommends use of helium with purity of 99.995%. (CGA 580)

n Nitrogen— purity of 99.9%. For analysis of materials with very low surface areas, Micromeritics
recommends use of nitrogen with purity of 99.995%. (CGA 580)

CRYOGEN REQUIREMENTS
Liquid nitrogen is commonly used as the cryogen to cool the sample during analysis. A liquid
nitrogen transfer system eliminates the need to pressurize storage Dewars. The Model 021 liquid
nitrogen transfer system is available from Micromeritics (www.Micromeritics.com).

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Gas Requirements and Purity
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1 Analyzer Components

SPECIFICATIONS FOR THE GEMINI VII

Surface Area From 0.1 m2/g, total
From 0.01 m2/g, specific

Pore Volume From 4 × 10-6 cm3/g

Analysis

Frequency 50/60Hz

Power 50VA

Voltage 100-240VAC

Overvoltage Category II

Electrical

Humidity 20% relative, non-condensing

Temperature 10 °C to 35 °C (50 °F to 95 °F), operating
0 °C to 50 °C (32 °F to 122 °F), non-operating

Indoor/Outdoor Use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax
Pollution degree of the intended environment: 2

Degree of Ingress
Protection IPX0

Environment

Adsorbate

Optimized for nitrogen in a liquid nitrogen sample bath. Gemini
may be used with non-corrosive adsorbate gases having vapor
pressures at both room and bath temperatures that are acceptably
high relative to the resolution of the 1,000 mmHg pressure trans-
ducer. Typically, oxygen, argon, carbon dioxide, butane, methane,
and other light hydrocarbons will produce useful data above abso-
lute pressures of a few mmHg.

Gases
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Height 59 cm (23 in.) - Gemini VII 2390a and 2390p
74 cm (29 in.) - Gemini VII 2390t

Width 40 cm (16 in.)

Depth 51 cm (20 in.)

Weight 32 kg (75 lbs.) - Gemini VII 2390a and 2390p
35 kg (78 lbs.) - Gemini 2390t

Physical

Range 0 to 950 mmHg

P/P0 Resolution <10-4

Relative Pressure Range 0 to 1.0 P/P0

Pressure Resolution <0.1 mmHg

Accuracy and Linearity
(transducer manufacturer
specification)

Better than ± 0.5% full scale

Pressure Measurement

Standard Tube

n Gemini VII 2390a and 2390p. 0.95 cm (3/8 in.) OD, 15.5 cm
(6.1 in.) long with 6.5 cm3 of volume. Sample capacity is approx-
imately 2.0 cm3.

n Gemini VII 2390t. 0.95 cm (3/8 in.) OD × 20.5 cm (8.1 in.) long
with 8.9 cm3 of volume. Sample capacity is approximately 2.0
cm3.

Dewar
n Gemini VII 2390a and 2390p. 8 hours
n Gemini VII 2390t. >24 hours

Sample Tube and Dewar

Specifications for the Gemini VII
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1 Analyzer Components

An external vacuum source achieving 20 × 10-3mmHg (or better) at the instrument inlet for oil-
based or oil-free pumps.

For oil-based pumps, an anti-suckback valve is required to prevent oil from being admitted into
the analyzer should there be a power failure. A device to reduce oil vapor backstreaming is also
recommended.

Vacuum System

Operating System

32- bit Windows 7 Professional or higher operating system is
recommended for the best user experience. For 21 CFR Part 11
environments, Windows 10 Professional or Windows 10 Enterprise
or higher is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access. Multiple users cannot operate the application at the
same time.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet based unit is connected to
the same computer, an Ethernet switch will also be required. If a
Smart VacPrep is to be used, an Ethernet switch is required.

Read/Write Permissions

All users of the application will need Read/Write permission to all
directories and subdirectories where the application is installed.
For 21 CFR Part 11 environments, permission may be limited to
the installation directory.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.
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2 ABOUT THE SOFTWARE

Software in 21CFR11 Environments on page 2 - 24

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Helpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into the predefined reports. Reports can also
be defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs, and copy and
paste graphics, are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Option Description
File Use to manage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit 

[n] displays on the menu bar for each analyzer attached to the computer.
Smart VacPrep (If installed.) Use to access the menu for each installed Smart VacPrep.

Reports Use to start or initiate reports and view the results.

Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Provides access to the embedded operator manual, the Micromeritics web
page (www.Micromeritics.com), and information about the application.

Main Menu Bar Options

2 About the Software

Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021 2 - 1



2 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Field or Button Description
Add Adds an item to the list.

Add Log Entry Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscalemeans that the x- and y- ranges
will be set so that all the data are shown. If Autoscale is not selected,
the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Use to enter additional information about the sample, such as a sample
lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments about the sample or analysis. Comments display in
the report header.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables deletes the selected information.

Destination Selects the report destination.

Edit When working with report parameters, highlight the item in the Selected
Reports list box and click Edit to modify the report details.

Common Fields and Buttons
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Field or Button Description
Exit Exits the application. If a file is open with unsaved changes, a prompt

displays providing the option to save the changes and exit or to exit the
application without saving the changes. If an analyzer is currently
operating, an additional prompt displays to confirm exiting from the
software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-
tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To When working with report parameters windows, indicates the From and
To range for x- and/or y-axes.

Insert Inserts one row above the selected row in the table.

List Creates a list of sample or other type files. The list will contain file
name, date / time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Replace All Selects another .SMP file where the values will replace all values for
the active sample file. The original file will remain unchanged. No ana-
lysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis and report-
ing parameters.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

Field or Button Description
Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. When sav-
ing sample information, a portion can be saved as a separate, stand-
alone file, such as Analysis Conditions or Report Options.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages.

Instrument Schematic. Displays a schematic of the analyzer system.

Common Fields and Buttons (continued)
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FILE STATUS
In the File Selector window, theMic Description column and theMic Status column display file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status Description
Analyzing Sample files that are currently being used for analysis.

Complete Sample files used in an analysis that has been completed.

Entered Sample files containing manually entered data.

No Analysis Sample files which have not been used to perform an analysis.

Prepared Sample files that have been used in an automatic degas operation
but have not been analyzed. This status is applicable only if using the
Smart VacPrep degasser.

Preparing Sample files that are currently being used in an automatic degas
operation. This status is applicable only if using the Smart VacPrep
degasser.

File Status

File Type File Name
Extension

Alpha-s Curve1 ) .ALS

Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Heat of Adsorption Report .HOA

Methods .MTH

Report Options .RPO

Sample Information .SMP

SPC Report .SPC

File Type and File Name Extension

1 ) Saves the relative pressures and resulting quantities adsorbed as an ASCII text file. These
data are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative pressure.

File Status
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2 About the Software

File Type File Name
Extension

Thickness Curve1 ) .THK

File Type and File Name Extension (continued)

File Type File Name Extension
Portable document format .PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup language .XML

File Types for Printing or Exporting

1 ) Saves the relative pressures and corresponding thicknesses as an ASCII text file. These data
are derived by dividing the condensed volume of adsorptive by the selected surface area. The
density conversion factor in the adsorptive properties file is used to convert quantity adsorbed to
volume of condensed adsorptive.
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KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F then pressingO opens the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Field or Button Description
Alt +[Unit n] Opens the Unit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Helpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens the Reportsmenu.

Alt + V Opens the Smart VacPrepmenu.

Alt + W Opens theWindowmenu.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector window.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.

F5 Opens the File Selector window listing report options files.

F6 Cascades open windows.

Keyboard Shortcuts

Keyboard Shortcuts
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2 About the Software

Field or Button Description
F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

F10 Opens the Heat of Adsorption window.

Shift + F2 Opens the File Selector window listing sample information files.

Shift + F9 Opens the shortcut menu of either the selected component on the analyzer
schematic when manual control is enabled or onscreen reports.

Keyboard Shortcuts (continued)
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OPTION PRESENTATION
Options > Option Presentation

For 21CFR11 environments, see Software in 21CFR11 Environments on page 2
- 24.

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to parameter

windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option is

used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-down
lists.

Restricted Displays the sample file in a single window similar to the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered to
change to the Basic or Advanced display option. This display type is
typically used in laboratories — such as the pharmaceutical industry —
where analysis conditions must remain constant. The Advanced option
is not available in the view selector at the bottom of the window when
using the Restricted display option.

Always Open Edit
View

Opens files with a Complete status in the tabbed file editor rather than
in the editor view.

Show Degas
Conditions

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab if not using a
Smart VacPrep.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

Option Presentation
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2 About the Software

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation Examples

Advanced view Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.
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LIBRARIES
Options > Manage Libraries

This feature is not available when using Restricted option presentation.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files that are stored in multiple locations— such as
folders on a C: drive, a network location, a connected external hard drive, or a connected USB
flash drive— providing access to all files. Even though libraries do not store actual sample and
parameter files, folders can be added or removed within each library.

One library can include up to 50 folders. Other items— such as saved searches and search
connectors — cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.

Libraries
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2 About the Software

METHODS

File > New Method

Options > Default Method

File > Open > [.MTH File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a
member in the Developer group using information in this section.

AMethod determines the default sample identification format and sequence number. AMethod is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single
selection is required for each new sample file created.

TheMethod drop-down list displays only those methods applicable to the open sample file type.

Developer Group view in a CFR21 environment

Default Method Examples Default Method Examples
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Analyst Group view in a 21CFR environment

Field or Button Description
Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labels may be renamed and the new label becomes a
part of all new sample files.

Sequence Number
[text box]

Specify a default numeric string to be used as a prefix in the Sample
field when a new sample file is created. This number increments with
each sample file created.

Default Methods

Methods
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2 About the Software

CONFIGURE THE ANALYZER

UNIT SELECTION

Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.
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UNIT CONFIGURATION

Unit [n] > Unit Configuration

Use to display and confirm hardware / software configurations and calibrations of the analyzer.

Field or Button Description
Volume Correction
[text box]

Displays the volume correction of the analyzer. If a different value is
entered in this field, it is stored with sample data at the beginning of
the analysis. The value in this field is used in calculating free space.

Change IP [button] Click to display the Unit IP Setup window. Use to change the IP
address and subnet mask assigned during installation. Do not edit
these fields unless instructed by a Micromeritics Service Rep-
resentative.

Delete Data From
Instrument [button]

Restores the controller to factory defaults.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Unit Configuration

Unit Configuration
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2 About the Software

INSTRUMENT STATUS

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

In 21CFR11 environments, see System Audit Trail on page 2 - 27.

Use to display a log of recent analyses, calibrations, errors, or messages.

Field or Button Description
Add Log Entry [button] Use to enter information to appear in the sample log report that can-

not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Instrument Log
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SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Use to enable the manual control of certain system valves and pump components on the analyzer
schematic.

When this option is enabled, a checkmark appears to the left of Unit [n] > Enable Manual
Control.

If the analyzer schematic is not immediately visible, go to Unit [n] > Show Instrument
Schematic.

A. Differential pressure trans-
ducer

B. Balance tube
C. Balance volume adjustment
D. Balance tube reservoir
E. Quantity adsorbed trans-

ducer
F. Sample tube reservoir
G. P ̀o tube, valve, and trans-

ducer reading are not dis-
played on Model 2390a

H. Sample tube
I. Elevator
J. Pressure relief valve

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.

Servo Valve. Closed.

Servo Valve. Open.

Analyzer Schematic Icons

Show Instrument Schematic
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2 About the Software

Icon or Symbol Description
Elevator.

Reservoir. For the balance tube and sample tube.

Volume adsorbed transducer (upper).

Differential pressure transducer (lower).

The reading for the volume adsorbed transducer is displayed just above the
symbol. The reading for the sample pressure transducer is displayed just
below the analysis servo valve and valve 5-s.
Balance volume adjustment. Can be adjusted by a Micromeritics Service
Representative.

Pressure relief valve. Prevents excessive pressure build-up in the event of
abnormal operation.

Balance tube and sample tube.

Analyzer Schematic Icons (continued)

Schematic
Components

Description

1 Vacuum valve

2 Adsorptive valve

3 Helium valve

4-b Balance reservoir valve

4-s Sample reservoir valve

5-b Balance port valve

5-s Analysis port valve

6 P0 port valve (models 2390 and 2390t only)

Analyzer Schematic Components
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Instrument Schematic Shortcut Menus

Icon or Symbol Description
Valve options For valves:

n Close. Closes the selected valve.
n Close both. Closes valves 4b and 4s or valves 5b and 5s.
n Open.Opens the selected valve.
n Open both.Opens valves 4b and 4s or valves 5b and 5s.
n Pulse. Use to quickly turn the valve on and off allowing the oper-

ation to proceed in small increments.

For servo valve:

n On/Off. Turns the servo valve on or off.
n Increase / Decrease. Increases pressure by dosing the sample.

Decreases pressure by evacuating the sample.
n Enter target. Displays the servo valve settings window. The

entered target pressure display to the left of the sample servo
valve icon.

For balance servo valve:

n Disable. Select to disable the balance servo valve. Operations for
the sample servo will also be performed by the balance servo.

n Enable. Select to enable the balance servo valve. Operations for
the sample servo will be ignored by the balance servo.

Elevator options Raise. Select Raise to raise the elevator. When it is moving, press
the keyboard space bar to stop the movement (or right click and
select Stop from the menu).

Lower. Select Lower and press the keyboard space bar to lower the
elevator.

Stop. Stops the elevator from moving.

Schematic Shortcuts

Show Instrument Schematic
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2 About the Software

SHOW STATUS

Unit [n] > Show Status
Use to show the current status for each port.

If multiple units are attached to the computer, select Show Status on each Unit [n]menu. The
status for all units displays.
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EXPORT FILES
File > Export
Exported Data Example on page C - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. When exported to a
file, the data can be imported into other applications that read these file formats.

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

Example of File List

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

The Setup program is located on the installation media and is used to reinstall the software and
make analyzer changes— such as adding, moving, or removing a unit, etc.

If the IP address needs to be changed on the computer connected to the analyzer,
refer to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP address must be 192.168.77.100.

Export Files
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2 About the Software

SOFTWARE UPDATES

User Account Control in the Windows operating systemmust be enabled to ensure all
components of the Micromeritics application are installed properly. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.Micromeritics.com).

When performing a software update, existing data files are not overwritten. There are three types
of subsequent installation:

n Later version than the current installation.
n Same version as the current installation.
n Earlier version than the current installation.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

Existing Confirm application users and groups are not affected by software updates.
Any changes to Confirm users and Confirm groups must be made using Windows
Users and Groups.
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SOFTWARE UNINSTALL
Uninstall Software in 21CFR11 Environments on page 2 - 28

The software can be uninstalled two ways. Either method removes only the files required to run
the software - not he analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file then follow the
screen prompts.

Software Uninstall
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SOFTWARE IN 21CFR11 ENVIRONMENTS

The Micromeritics Confirm applications for 21CFR11 environments require an
operating system of Windows 10 Professional or Windows 10 Enterprise or higher.
Management of users and groups is performed in Windows Users and Groups.

The Micromeritics Confirm application enables laboratory managers to develop analysis methods,
enforce industry standards, and produce audit trails. It also enables laboratory analysts to perform
analyses and produce reports.

USER PERMISSIONS

Confirm User Name Description
mic_[analyzer model
number]_controller

mic_[analyzer model number]_controller is the user name used by all
installations.

n This user should have complete control over the installation dir-
ectory.

n The application is launched under this user name and has this
user’s privileges to the windows file system.

n This user should not be used by anyone or any other software that
is not a Micromeritics application.

n The system administrator has the option of modifying this account
so that the password never expires. Alternatively, if the password
does expire while the application is running, the application auto-
matically changes the password for this account.
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Confirm Group Name Description
Developer Group The default Developer group name is

mic_[analyzer model number]_developer. Members of the
Developer group:

n have rights to all functions of the Micromeritics application - includ-
ing Advanced option presentation which allows the creation and
modification of methods, sample files, and parameter files.

n can run an analysis.
n can also be assigned Administrator rights which control the user

profiles.

Analyst Group The default Analyst group name is
mic_[analyzer model number]_analyst. Members of the Analyst
group:

n have access to the Basic presentation option only.
n may create sample files from pre-defined methods and can modify

only a limited number of input fields.

Software in 21CFR11 Environments
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OPTION PRESENTATION FOR 21CFR11 ENVIRONMENTS

Options > Option Presentation

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

For members of the Developer group only. To change the view from Advanced
(for Developers) to Basic (for Analysts), click the view selector drop-down list at the
bottom of the window. Select either Advanced (when in Basic view) or Basic (when
in Advanced view).

Advanced view / Developer group Basic view / Analyst group

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.
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n The Save button is disabled on sample files with a Complete status.
n When the Preview button is used to view reports for sample files with an unsaved status, the

report will have a Preview watermark.
n The Save As and Print buttons on the report window are also disabled.

CREATE A NEW FOLDER
File > Create New Folder
Provides the option to create and name a new folder in the Confirm application folder. This option
may not be available depending on how the IT Administrator configures Windows permissions.

SYSTEM AUDIT TRAIL
File > System Audit Trail

Lists the current user, successful and failed application user login attempts, and contains a
description of all the changes made to sample files. Contains an audit trail of all system
initializations, user login attempts, and sample analyses.

Option Presentation for 21CFR11 Environments
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UNINSTALL SOFTWARE IN 21CFR11 ENVIRONMENTS

When the software is uninstalled using uninstall.exe, only the files required to run the application
are removed. Parameter files, sample files, reports, calibration files, and data files are not
removed.

To uninstall the software, double-click the uninstall.exe file located in the software installation
directory, then follow the prompts.

To uninstall the Micromeritics Confirm application, the owner of the application
directory and its contents must be set to the account of the administrator that is
removing the application installation. This account must also have permission to
modify the application directory and its contents. This may require modification to the
owner and to the access permissions of the application directory and its contents.

Upon uninstalling the Confirm application, the system administrator should go into
Windows Users and Groups to remove the Confirm users and groups. See the
Confirm Administrator Guide [part number 004-42821-01].

Depending on the network, Windows may not allow the uninstall.exe program to run. If this
happens. follow these steps:

1. In Windows Users and Groups, verify that the current user is not a member of the analyst
group or developer group. If so, remove the user from the group(s). Log OFF, then log back
ON to the computer.

2. In Windows Explorer, in the Confirm installation directory, double-click the uninstall.exe file
to run the uninstall program.
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3 SAMPLE FILES
Software in 21CFR11 Environments on page 2 - 24

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, and specifies report options and may be
displayed in Advanced, Basic, or Restricted presentation display mode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited as needed without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

3 Sample Files
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3 Sample Files

CREATE SAMPLE FILES
Options > Option Presentation > Show Degas Conditions

File > New Sample > [.SMP File]

File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a
member in the Developer group using information in this section.

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation, or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation must be selected from parameter files
created in the Advanced option presentation. The values specified in the parameter portions of the
default method are the defaults for new sample files. To navigate from one set of parameters to
another, select the parameter tab across the top of the window.

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions

Advanced or Developer view Basic or Analyst view
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A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Field or Button Description
Add Log Entry [button] Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] * Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments about the sample or analysis. Comments display in
the report header.

Mass [group box] Enter a value for sample mass. Mass can be changed any time
before, during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.

Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. Equation used
to calculate sample mass:

Masssample = Masssample+tube – Masstube
Method [drop-down box] Select a method from the drop-down list.

Operator [text box] * Enter operator identification information.

Sample [text box] * Enter a sample description.

Submitter [text box] * Enter submitter identification information.

Type of Data
[group box]

Automatically collected. Select if the type of data will be
automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. IfManually entered is selected, the Isotherm
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 7.

Sample Files

Create Sample Files
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3 Sample Files

Field or Button Description
User Parameters
[group box] *

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report. See SPC Report on page 6 - 2.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Sample Files (continued)

* This field label may have been renamed or may not display if modified inOptions > Default
Methods.
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OPEN A SAMPLE FILE
File > Open > [.SMP File]

When working with an existing sample file, consider making a copy of the sample file
to maintain the original configuration options.

File Status Displays
Preparing
Prepared
No Analysis

Tabbed file editor

Complete
Analyzing
Entered

MicroActive report window

File Editor Example for CFR21

Advanced or Developer view Basic or Analyst view

Open a Sample File
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3 Sample Files

Example of a Report window

If a sample file with a Complete status is opened, to return to the tabbed file editor, select
Advanced or Basic from the view selector drop-down list at the bottom of the window.

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

3 - 6 Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021



MANUALLY ENTER DATA

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

This process allows the manual entry of pressure data from a sample file with a Complete status.
There are two methods for manually entering data into a sample file:

n Copy and paste onto the graph area of the interactive window.
n Import data into the interactive window.

COPY AND PASTE MANUALLY ENTERED DATA

To display the file status in a search window, go to File > Open. Right-click the
column header then clickMore... Scroll to theMIC entries and enableMIC Status.This
is a snippet

1. Open a sample file with a Complete status. The file will open in the interactive reports win-
dow.

2. Right-click in the graph area of the interactive reports window, then select Copy data.

Example of Report window

3. Open another sample file using the Advanced option presentation.
4. On the Sample Description tab, selectManually entered in the Type of Data group box.
5. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Isotherm.

Manually Enter Data
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3 Sample Files

6. Ensure that all parameter fields are set appropriately, then click Paste.
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IMPORT MANUALLY ENTERED DATA
When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Data must be in two columns and separated by a comma or white-space. Acceptable column
headings are:

n Relative Pressure
n Absolute Pressure (mmHg)
n Absolute Pressure (kPa)
n Absolute Pressure (mBar)

n Quantity Adsorbed (mmol/g)
n Quantity Adsorbed (cm³/g STP)
n Quantity Adsorbed (cm3/g STP)

Sample Physisorption ASCII Text File

Silica Alumina : Adsorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.108629 50.6657
0.22288 60.7813
0.339909 71.3095
0.459512 84.4172
0.577447 102.672
0.654583 121.707
0.760074 179.096
0.855713 334.565
0.958511 394.675
0.996251 403.793

Silica Alumina : Desorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.996251 403.793
0.86016 389.626
0.753567 256.264
0.664418 133.099
0.542416 96.7366
0.422295 79.7351
0.346371 71.5994
0.2519 62.8256
0.152718 54.2336
0.103389 49.5803

Manually Enter Data
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3 Sample Files

To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. On the Sample Description tab, selectManually entered.
3. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Isotherm.

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an

error message displays instead, verify that the .TXT file format is correct.
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4 PARAMETER FILES

In 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Parameter file information that is available to Analysts is created by a
member in the Developer group using information in this section.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited as needed without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited, as needed, or new
parameter files can be created.

The following file types can exist as part of the sample file as well as individual parameter files.

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Method .MTH

Report Options .RPO

Sample Tube .STB

Parameter File Types

4 Parameter Files
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4 Parameter Files

ADSORPTIVE PROPERTIES
File > Open > [.ADP File]
Or, click Edit next to the Adsorptive selection on the Analysis Conditions tab when in Advanced
option presentation.

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

Field or Button Description
Adsorbate molecular
weight [text box]

The molecular mass is used for the weight % column of the isotherm
tabular report and for the pressure composition isotherm plot.

Adsorptive [text box] Name of the adsorptive gas whose properties are being defined.

Density Conversion
Factor [text box]

Factor determined by obtaining the ratio of the gas density (STP) to
the liquid density.

Mnemonic [text box] Enter the mnemonic name for the adsorptive.

Molecular cross-sec-
tional area [text box]

The area that a single adsorbed molecule occupies on the surface of
the sample. It is used in surface area calculations.

Non-ideality factor
[text box]

Compensates for the forces of attraction between molecules in a real
gas. This value is used for a calculated free space.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Adsorptive Properties
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ANALYSIS CONDITIONS
File > Open > [.ANC File]
Or, click the Analysis Conditions tab when in Advanced option presentation.

Analysis conditions specify the parameters used to guide an analysis.

Field or Button Description
Absolute pressure
dosing [check box]

Specifies pressure targets in mmHg, mbar, or kPa instead of relative
pressure. If this option is selected, the Relative Pressure labels and
entries change to Absolute Pressure in the selected pressure units.
This option is typically selected when using adsorptives at analysis
conditions above the critical point of the gas; for example, H2
adsorption on carbon at liquid nitrogen temperature.

Adsorptive [text box] Select an Adsorptive Properties file from the list of defined gases to be
used for analysis. After selection, click Edit to modify adsorptive prop-
erties.

Analysis conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis con-
dition parameters to be used in the analysis.

Analysis Conditions

Analysis Conditions
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4 Parameter Files

Field or Button Description
Analysis Method
[button]

Use to enter equilibration time in seconds or enter the minimum
equilibration time for scanning in minutes

Free Space [button] Use to specify how free space is determined.

None. Select if free space will not be used.

Previously measured. Select if free space has been previously
measured. Recommended if measuring a series of samples with
similar volumes.

Measure. Select if the free space is to be measured before the analysis
begins.

Enter. Allows manual entry of free space.

Calculate. Select to have the free-space calculated using the value
entered for Volume Correction (entered on the Unit [n] > Unit
Configuration window) and the non-ideality factor (entered on the
Adsorptive Properties window).

Analysis Conditions (continued)
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Field or Button Description
p° and T [button]

Use to select options for obtaining the saturation pressure (p°) and
analysis bath temperature.

Entered. Select to manually enter the p°.

Most recent measured. Select to use the most recently measured
saturation pressure.

Measure p° for each point (models p and t only). Select if p° is to be
measured for each point.

Bath temperature. Calculates p° using the entered bath temperature.

Analysis Conditions (continued)

Analysis Conditions
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4 Parameter Files

Field or Button Description
Preparation [button] Use to enter analysis preparation details.

Evacuation rate. The maximum rate of change of pressure when
evacuating the sample tube.

Evacuation time. The length of time for preliminary evacuation which
takes place prior to the free space measurement or sample analysis if
free space is to be entered or calculated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Analysis Conditions (continued)
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DEGAS CONDITIONS
File > Open > [.DEG File]
Or, click the Degas Conditions tab when using Advanced option presentation.

Use this option only when the Smart VacPrep is installed. Degassing is a required
step in preparation for an analysis. The Degas Conditions tab provides settings that
will be automatically applied during the degassing procedure when using the Smart
VacPrep.

If using a FlowPrep or a VacPrep use the heating phase section for reference only.

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions.

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.Micromeritics.com).

Field or Button Description
Copy QuickStart
degas conditions
from Smart VacPrep
Unit [drop-down box]

Use to copy the degas conditions settings from the selected
Smart VacPrep unit and port.

Degas conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Degas Conditions

Degas Conditions
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4 Parameter Files

Field or Button Description
Heating Phase [table] This option is applicable when degassing with a Smart VacPrep .

Enter up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time. How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Smart VacPrep
Evacuation
[group box]

Backfill sample tube. Indicate if the sample tube should be backfilled
automatically or wait for operator response.

Evacuation rate. Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with the Heating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This prevents damage to the sample
structure due to 'steaming' and /or elutriation due to excessive
escaping gas velocity.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate. Rate at which the temperature is to change
when advancing to the target pressure.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Degas Conditions (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
Or, click the Report Options tab when in Advanced option presentation.

About Reports on page 6 - 1
Selected Report Options on page 7 - 1

The Calculations document can be found on the Micromeritics web page
(www.Micromeritics.com).

Additional reports are available using the Reportsmenu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.

Report Options
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4 Parameter Files

Field or Button Description
Edit [button] Opens a dialog box for settings options for the selected report. Select

the reports to include in the report preview, printed report, or report
file.

Overlays [button] SeeGraph and Sample Overlays on page 6 - 27.

Report Options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports
[group box]

Select the report names to include in the report.

Show graphic [text box] Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Report Options
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5 PERFORM AN ANALYSIS

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

DEWAR PRECAUTIONS

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

When handling Dewars containing liquefied gases or cryogenic liquids:

n Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

n When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

5 Perform an Analysis
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5 Perform an Analysis

FOR GLASS DEWARS

n Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or
other materials of extremely low temperature). Do not use a glass or metal stirring rod unless it
has a protective coating.

n Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the
Dewar opening. If an object of sufficient weight is accidentally dropped into the Dewar, shat-
tering may occur.

n If the Dewar has a protective mesh covering, do not remove it. This cover minimizes the risk of
flying particles should the Dewar be knocked over, dropped, or broken.
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PREPARE FOR ANALYSIS
The steps in this topic properly prepare the equipment for an analysis. It is recommended to
perform the tasks in the provided order.

CLEAN AND LABEL SAMPLE TUBES

The equipment images in this topic may differ slightly from your equipment;
however, the instructions are the same unless otherwise noted.

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are needed for cleaning. The procedures following the
materials list are recommended.

Supplied by Micromeritics Supplied by User

n Filler rod
n Funnel
n Sample data worksheet
n Sample tube
n Sample tube brush
n Sample tube rack
n Sample weighing support
n Stopper for sample tube

n Acetone or isopropyl alcohol
n Analytical balance
n Detergent (such as Alconox)
n Drying oven
n Forceps
n Insulated gloves
n Pipe cleaners
n Rubber gloves or clean, lint-free cloth
n Safety glasses
n Ultrasonic cleaning unit
n Waste container

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.
3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the

ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.

Prepare for Analysis
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5 Perform an Analysis

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in
the rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high purity acetone or isopropyl alcohol and
dried for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube
is installed on the analysis port.
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10. Blow out the sample tubes with oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper.

Clean and Label Sample Tubes
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5 Perform an Analysis

DETERMINE THE SAMPLE MASS

Sample Data Worksheet for Gas Adsorption on page E - 2

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Clean, dry sample tubes are essential for accurate results. How much sample to use can be
determined best by experiment. In general, a sample providing 40 to 120 square meters of total
surface area is recommended for nitrogen analysis. Less than 40 square meters may cause
unreliable results. More than 120 square meters will extend analysis time.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total weight. Proper weighing techniques are most important in this case. Use no less than 100 mg
to reduce the effect of weighing errors.

Care should be taken when loading powders: the accessory funnel is useful for this purpose.
Large granules or chunks may be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is
important to know the true sample mass.

Follow the instructions on the Sample Data Worksheet and complete all fields to find the true
sample mass.

1. Record the sample tube identification on the Sample Data Worksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize

at zero (0).
3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing

support and place it on the balance.
4. Record the stabilized mass on the Sample Data Worksheet . Remove the sample tube set

from the balance.

Do not touch the sample with bare hands while performing the following steps. Doing
so could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero.
6. Slowly pour the specified amount of sample into the sample container.
7. Remove either the rubber stopper from the sample tube.
8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the

weighing container into the sample tube.
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9. Replace the rubber stopper.
10. On the Sample Data Worksheet, record the following:

n Mass of the sample tube set with the sample.
n Subtract theMass of empty sample tube set from theMass of sample tube set plus

sample.

Determine the Sample Mass
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5 Perform an Analysis

DEGAS THE SAMPLE

If using the Smart VacPrep degasser, go to Smart VacPrep > Unit [n] >
Start Degas, then degas the sample using menu commands and
information entered on the Degas Conditions tab. The Smart VacPrep
Operator Manual can be found on the Micromeritics web page
(www.Micromeritics.com).

After the sample has been weighed, use a degassing unit to remove any contaminants which may
have adsorbed to the surface or pores. Appropriate degassing units are available from
Micromeritics.

After degassing is complete, perform the following steps:

1. Weigh the sample tube set containing the sample. Record the mass on the Sample Data
Worksheet for Gas Adsorption on page E - 2 asMass of Sample tube set plus sample
(After Degas).

2. Subtract theMass of empty sample tube set (Before Degas) from theMass of Sample tube
set plus sample (After Degas) to obtain the sample’s mass. Record this value asMass of
sample (After Degas).
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SAMPLE TUBE INSTALLATION

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Remove the sample tube stopper, if used.
2. Place the connector nut, ferrule, and O-ring onto the sample tube stem. The sample tube fer-

rule is tapered slightly on one end, however it may be installed with the tapered end in the
up or down position.

A. Sample tube or balance tube
B. Connector nut
C. O-ring
D. Ferrule

If analyzing samples with a surface area of 1.0 m2 or less, use filler rods in the sample
and balance tubes. See Analyze Samples with a Total Surface Area of 1.0m2 or
Less on page A - 1 .

3. Attach the sample tube to the analysis port. Ensure it is fully in the port. Secure it in place by
screwing the connector nut into the analysis port. Hand tighten the connector nut.

4. If the balance tube is not installed, attach it to the balance port following the above pro-
cedures. If a filler rod was used in the sample tube, one must be used in the balance tube.

It is not necessary to remove and replace the balance tube between analyses unless
it has been contaminated or if using a different size sample tube.

Sample Tube Installation
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5 Perform an Analysis

5. Place the Dewar cover under the sample and balance tubes and slide upward until it is 7.5
cm (3 in.) from connector nuts.
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FILL AND INSTALL THE DEWAR

Dewar Precautions on page 5 - 1

1. Fill the Dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than 1 in.
(2.5 cm) from the top for a large Dewar or no higher than 3/4 in. (2 cm) from the top for a
smaller Dewar.

Incorrect fluid levels can lead to measurement errors. Check the level of the bath
liquid before each analysis.

2. Check the level of the analysis bath liquid. For best results, if the Dewar has not been used
for a while, allow approximately 30 minutes for the temperature of the Dewar to stabilize
with the bath liquid, then recheck the level of the bath liquid. Add additional liquid if
necessary.

3. Slide the Dewar cover to approximately 7.5 cm (3 in.) from the sample port nuts to ensure a
proper seal on the top of the Dewar.

4. Place the Dewar on the elevator. A Dewar support is not necessary for the larger Dewar
used with the Gemini 2390t. Place the Dewar directly on the elevator.

5. Close the safety shield on the front of the analyzer.

Fill and Install the Dewar
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5 Perform an Analysis

PERFORM A SAMPLE ANALYSIS
Unit [n] > Start Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Ensure the analyzer safety shield is closed before beginning an analysis. If the ana-
lyzer is operated at an excessive pressure, the sample or balance tube could become
dislodged from its port, possibly causing personal injury or damage to the equipment.

Field or Button Description
Density / Mass /
Sample + Tube /
Empty Tube [text box]

Enter values for the sample’s mass and density. These values may
be edited after analysis.

New [button] Creates a new sample file.

Sample tube
[drop-down box]

Select the sample tube to be used for this analysis.

Start [button] Click to start the analysis.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Sample Analysis
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A. Port report buttons
B. Live graph settings

Field or Button Description
Live Graph Settings
[button]

Select Thermal transpiration, x-axis Quantity (relative or absolute
pressure), and the x-axis Scale (linear or logarithmic).

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

Display Port [button] Generates a report on data being collected . The reports are
displayed on the computer monitor only.

Status window Displays the last point pressure and relative pressure for each port.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Sample Analysis Graph

Perform a Sample Analysis
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PERFORM AN EMPTY TUBE ANALYSIS
Unit [n] > Empty Tube Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

The volume correction is only used when calculated free space is selected. It accounts for any
difference in volume between the balance tube and the empty sample tube, and may be
determined by the following procedure: Perform a liquid nitrogen analysis using two empty sample
tubes of the same size. Select Measure for free-space option (see Perform an Empty Tube
Analysis for Diagnostic Purposes on page 10 - 17). After the analysis, record the reported
free-space difference in the Unit Configuration dialog (cross-reference) and use it for these two
tubes only for future analyses with calculated free space.

Ensure the analyzer safety shield is closed before beginning an analysis. If the ana-
lyzer is operated at an excessive pressure, the sample or balance tube could become
dislodged from its port, possibly causing personal injury or damage to the equipment.

1. Click Browse to select a sample file.
2. Click Report after analysis to automatically generate reports when the analysis is com-

plete. On the Report Settings window, select the report destination. ClickOK.
3. Click Start to start the analysis. A window displays data as they are collected. A short delay

is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.
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4. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.

Perform an Empty Tube Analysis
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5 Perform an Analysis

PERFORM A REFERENCE MATERIAL ANALYSIS

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

A reference material analysis is used to verify the analyzer is operating properly and producing
optimum results. These methods provide specifications for critical report quantities and reporting
of whether quantities are in or out of specification.

When running a reference material analysis, use the appropriate reference material provided in
the accessories kit to perform this analysis. The results should match those shown on the label of
the reference material bottle, within the tolerance level.

Ensure the analyzer safety shield is closed before beginning an analysis. If the ana-
lyzer is operated at an excessive pressure, the sample or balance tube could become
dislodged from its port, possibly causing personal injury or damage to the equipment.

1. Go to File > New Sample > [.SMP] to create a new sample file.
2. Click Replace All. Locate and select the file Carbon.smp. Click Load. This file contains the

appropriate conditions for analyzing the carbon reference material. All values will be copied
into the new sample file. Edit fields as needed.

3. Click Save As, enter a new file name if necessary, click Save, then click Close.
4. Clean and label a sample tube. If installing a new balance tube, clean and label it also.
5. Determine the sample mass.
6. Degas the sample using a degassing unit.
7. Install the sample tube with degassed sample on the sample port.
8. Install the balance tube (if not installed) on the balance port.
9. Fill the Dewar with liquid nitrogen to about 5 cm (2 in.) from the top. Allow the Dewar to equi-

librate to ambient conditions (approximately 30 minutes).
10. Close the sample compartment door.
11. Go to Unit [n] > Start Analysis.

5 - 16 Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021



12. Click Browse. Locate and select the sample file created previously for this analysis. Click
Open.
a. Click Report After Analysis.
b. Select Report after analysis and Preview as the destination. ClickOK.

13. Click Start.
14. Compare the BET Surface Area in the report with the BET Surface Area on the reference

material bottle.

n If results are within tolerance, the analyzer is operating properly.
n If results are not within tolerance, refer to the following table for possible causes and

actions. After performing the action, perform the reference material analysis again.

Cause Action
The sample was not degassed properly. Degas the sample again.

The gas lines are not clean. Clean and verify the gas lines.

The measured free space is too high.
This indicates the helium may not be
pure enough.

Helium must be 99.995% pure.

Perform a Reference Material Analysis
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5 Perform an Analysis

PERFORM A QUICKSTART ANALYSIS
Unit [n] > QuickStart Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

TheQuickStart Analysis option automatically creates a sample file and assigns the default
parameters. Click Edit to modify the parameters or Browse to select another file.

Ensure the analyzer safety shield is closed before beginning an analysis. If the ana-
lyzer is operated at an excessive pressure, the sample or balance tube could become
dislodged from its port, possibly causing personal injury or damage to the equipment.

Field or Button Description
Sample tube
[drop-down box]

Click the drop-down arrow to select a sample tube file. This option is
applicable only if the calculated method for measuring free space is
selected for analysis conditions.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

QuickStart Analysis Fields and Buttons
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MEASURE SATURATION PRESSURE
Unit [n] > Start p° Measurement

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Starts a saturation pressure measurement.

Gemini Model Description
2390a p° can only be measured in the sample tube, therefore selections are

not provided. Verify that a sample tube is attached to the sample port
and that it does not contain a filler rod. Click Start.

2390p and 2390t A p° tube is installed on these models. p° can be measured in the p°
tube or in the sample tube. If using a sample tube, ensure that a
sample tube is attached to the sample port and that it does not con-
tain a filler rod. Click Start.

After analysis, go to Unit [n] > Unit Configuration. The recorded value now displays in the Last
Measured Po field.

Measure Saturation Pressure
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6 ABOUT REPORTS
Reports > Start Report
Generates a report on a sample analysis.

Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

Reports > SPC Report Options
See SPC Report on the next page.

Reports > Regression Report
See Regression Report on page 6 - 3.

Reports > Control Chart
See Control Chart Report on page 6 - 5.

Reports > Heat of Adsorption
See Heat of Adsorption Report on page 6 - 8 .

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
either Complete or Analyzing.

6 About Reports
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6 About Reports

SPC REPORT
Reports > SPC Report Options
Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more
efficient to select only the necessary variables.

The selected items display as graph variable selections in Reports > Regression Report and
graph selections in Reports > Control Chart. If report options for NLDFT Advanced PSD are
required, clickMore.
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REGRESSION REPORT
Reports > Regression Report
Use to generate a Statistical Process Control (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

Field or Button Description
Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in
the sample files.

Recalculate archived
SPC results [check box]

The first time this option is used, the time it takes to generate the
report is lengthened. The second time the report is generated, if
using the same sample files used in the initial calculation, it is
recommended that this option not be selected since the data was
recalculated previously. If a sample file is added or removed from the
report after the initial recalculation, this option should be selected
again to ensure the data from the newly added or removed sample
file is recalculated.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] Click to save selected report options as default report settings.

Gas Adsorption Regression Report

Regression Report
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6 About Reports

Field or Button Description
Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples that contains the
numeric values contributed by each sample.

X- and Y-Axis variable
[drop-down box]

Designates the x- and y-axes variables. The variables in the drop-
down lists are those selected in the Reports > SPC Report Options
window. Use these options to plot the regression of up to three y-axis
variables against the x-axis variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Gas Adsorption Regression Report (continued)
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CONTROL CHART REPORT
Reports > Control Chart
Generates a Statistical Process Control (SPC) chart report which plots the changes in a statistic.

Field or Button Description
Graph [n] [button] Defines the y-axis of each graph.

Statistic. Displays the SPC variables selected on the Reports >
SPC Report Options window. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis
label.

Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To
fields.

Gas Adsorption Control Chart Report

Control Chart Report
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6 About Reports

Field or Button Description
Center Line. Displays placement options for the center line in the
graph. Select Entered to specify placement of the line orMean to
place the center line at the calculated mean value for the selected
samples.

Limit Lines. Displays limiting lines options. Lines can be placed at
some multiple of the standard deviation or at specified positions
(Entered). When Entered is selected, enter the High limit and Low
limit fields with appropriate values.

Recalculate archived
SPC results [check box]

The first time this option is used, the time it takes to generate the
report is lengthened. The second time the report is generated, if
using the same sample files used in the initial calculation, it is
recommended that this option not be selected since the data was
recalculated previously. If a sample file is added or removed from the
report after the initial recalculation, this option should be selected
again to ensure the data from the newly added or removed sample
file is recalculated.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples that contains the
numeric values contributed by each sample.

Gas Adsorption Control Chart Report (continued)
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Field or Button Description
X Axis Order By
[group box]

Select the order in which x-axis statistics are placed. Sort by: 

Time. Time the files were analyzed.

File name. Alphanumeric order.

Date. Date the files were analyzed.

Minutes.Minutes elapsed from the first file placed on the list, which
is the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Gas Adsorption Control Chart Report (continued)

Control Chart Report
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6 About Reports

HEAT OF ADSORPTION REPORT
Reports > Heat of Adsorption

Use to select sample files, define quantities, and generate a Heat of Adsorption report. The
isosteric heat of adsorption is an important parameter for characterizing the surface heterogeneity
and for providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different
temperatures to obtain the heat of adsorption.

Field or Button Description
Add Samples [button] Adds a sample file to the table.

Clear Samples [button] Removes all entries from the table.

Edit Quantities [button] Specifies the range of surface coverage to include in the report.

Heat of Adsorption Report
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Field or Button Description

Insert Range. Specifies the starting and ending quantities adsorbed
and number of points to insert.

Load Table. Imports values from another file.

Save Table. Saves the current table as a .QNT file.

Apply. Applies all table changes.
Heat of adsorption plot
[selection]

Generates the Heat of Adsorption data in a graphical format.

Isostere plot [selection] Generates a graph showing quantities of gas adsorbed versus the
temperature.

Remove Sample
[button]

Removes the selected sample from the list.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples that contains the
numeric values contributed by each sample.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Heat of Adsorption Report (continued)

Heat of Adsorption Report
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6 About Reports

INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. When opening a sample file that contains analysis data, a window with the following inform-
ation will display:

n a linear plot and log plot of the data collected during analysis.
n a summary of the analysis giving a single total pore volume and surface area.

2. To view the plots in either relative or absolute pressure, select either the Relative Pressure
or Absolute Pressure option.

3. To view the reports selected for generation during the analysis, click Preview.
4. From the view selector drop-down list at the bottom of the window, do either of the following:

n Change the option presentation of the sample description window to either Basic or
Advanced to modify certain file parameters.

n Select another plot from the list and edit the data contained in the plot.

5. When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:

n Drag the blue bars to increase or decrease the range of data included in the plot.
n Right-click to display a popup menu to include reports; enable or select overlays; edit

curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

6. Click Save.
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MICROACTIVE REPORTS
MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easy way to investigate and manipulate analysis data using a variety of
reporting methods.

When a sample file with a status of Complete, Analyzing or Entered is opened, a linear plot and
log plot of the data collected during analysis are displayed as well as a summary of the analysis
giving the total pore volume. Numerous reports are accessible from a drop-down menu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are
also displayed. Plots may be edited by selecting the data points or data point range to be included
in the plots and modifying the parameters. When a report is edited, the results are immediately
reflected in the plots and summary data.

MicroActive Reports
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6 About Reports

EVALUATE REPORT RESULTS
Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reduction methods. This topic discusses the
elements of various reports presented by Micromeritics’ analyzers and suggests ways by which
the merit of the reported information may be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriate methods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

n Viewing the Validation Report
n Inspecting the Isotherm Plot
n Evaluating the Isotherm Tabular Data Set
n Reviewing Reduced Data
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VIEW THE VALIDATION REPORT
The Validation report shows whether the data collected during an analysis are within typical
ranges. Select the types of reports to include by selecting the report in the Validation Report
Options window.

When a selected report is generated, if errors occur, a message is displayed across the top
portion of the report and a unique symbol displays on the graph.

INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected to mathematical smoothing as far as possible. If
the data describe a Type I isotherm, then the plot is best shown on a logarithmic pressure axis so
that details of the low pressure region are revealed. Data in this region are important particularly
for micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical
process being monitored. The philosophical question of whether or not these suspected
extraneous data points should be removed from the raw data is not considered here, but it may be
appropriate to exclude an outlier from reduced data. Too many outliers can cause the integrity of
the total data set to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under
reasonable conditions and using reasonable parameters. For example, confirm that the free
space values reported are typical for the sample holder and bath in use. A problem with either
ambient or analysis free space values may indicate a free space measurement error and affect all
calculations of quantity adsorbed.

Evaluate Report Results
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6 About Reports

The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.1 )

EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/P0 = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the sample mass (g). As an example, the level of uncertainty in this range typically is less than
0.1 cm3 STP for a high performance system. Total uptake quantities should be some multiple of
this level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result.
The solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changes may indicate
that a gas different from the adsorptive was used in determining P0, that the level of the cryogen
fell too far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular
and graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.2 )

REVIEW REDUCED DATA

Isotherm data may be analyzed by any one of several reduction methods depending on the
analyzer model and pressure range employed. The quality of the results depends on the quality of
the isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which the method is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.3 )

1 ) The information in this article is extracted from Analytical Methods in Fine Particle Technology,
Webb, P. and Orr, C., (1997).
2 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
3 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
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PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be
reviewed to assure that they agree with experimental conditions. These parameters can be
changed and the experimental data recalculated if an error is discovered or if exploring an
alternate value is desired. Analysis condition values used in the calculation of quantity adsorbed
can be changed also. These are typically the manually entered free space(s), nonideality
correction factor, and bath temperature.

The area occupied by a single adsorbed molecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger1 ) provide a comprehensive review
of such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them
by converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptives must be
calculated.

The terms for liquid surface tension , contact angle between solid and liquid phase , molar
volume of the adsorbate , gas constant , and sample temperature are treated as one
constant, the adsorbate property factor expressed by:

using which, the Kelvin equation2 ) reduces to

Either surface tension, contact angle, or molar volume can be revised individually to give a new
value for the factor , or can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters which may be adjusted from those
of the default values. The first is the inside stem (neck) diameter of the sample holder, and the
second is the hard-sphere diameter of the adsorptive molecule. The sample holder inside
diameter is available from the documentation provided with it or is measurable. Information on
hard-sphere diameters of molecules may be obtained from handbooks.

1 ) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577
(1967).
2 ) Thomson, W., Phil. Mag. S., 42, 448 (1871).

Evaluate Report Results
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6 About Reports

For terms such as the interaction parameter found in the Horvath-Kawazoe calculation1 ) , the
Dubinin affinity coefficient, or Astakhov exponent2 ) , the default values as provided by the
software generally are adequate. A search of the technical literature is required if the analysis
involves a gas-solid system other than that covered by the default values.

The t-Plot method plots quantity adsorbed against thickness (t) derived from a thickness equation,
and the Dubinin transform plots quantity adsorbed against log(P/P0)n. All of these data reduction
methods were first proposed for specific applications. The user must make a judgment as to the
applicability of the method to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysis
must be applied only over the linear range and within the range of application. Fitting a regression
line to surface area transformation plots should yield a correlation coefficient of 0.9999 or better
and for t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reduction model does not apply to the gas-solid system under examination, then it may
be that either no linear range exists within the pressure range of validity, or that solutions derived
from the regression line of the linear range are intuitively incorrect, that is, they have no relevance
to the physical situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also
assumes that the gas is more strongly attracted to the surface than to other gas molecules. The
typical range of BET C-values is from about 5 to well over 100. Values much less than 5 imply that
the gas-to-gas affinity is competing with the gas-to-solid affinity which conflicts with the basic
assumptions of BET theory. C-values much greater than 100 indicate very strong attraction for the
surface or preferential adsorption.

Provided the isotherm was determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular sample material does not conform to the BET model. An
inappropriate adsorption model may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about the minimum value expected with five more or less equally
spaced points. In the case of indications of poor conformance to the BET model, the Langmuir
data reduction method should be examined.

1 ) Everett, D.H. and Powl, J.C., J. Chem Soc., Faraday Trans. 1, 72, 619 (1976).
2 ) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).
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DATA ANALYSES BY THE BJH METHOD

In general, this method visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive
involved is divided between pore-emptying and film-thinning processes and is accounted for
totally. This computational algorithm frequently leads to inconsistencies when carried to small
mesopore sizes. If the thickness curve used is too steep, ultimately it will predict a larger
increment of adsorptive for a given pressure increment than is actually observed. The algorithm
must stop since a negative pore volume is nonphysical. Accumulated error results in the
calculation of a too large volume of (possibly nonexistent) small pores if the thickness curve used
underestimates film thinning.

Evaluate Report Results
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6 About Reports

REPORT FEATURES AND SHORTCUTS

In 21CFR11 environments, members of the Analyst group must click Preview on the
sample file window to access this screen.

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the

axes.
n All reports contain a header displaying file statistics.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

If configured, the report header can also contain a graphic and/or a title.

n Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-
time, analysis conditions, etc.

n The headers contain notes of sample file changes occurring after analysis.
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REPORT HEADER SHORTCUTS
Right-click in the report header to display header shortcuts.

Field or Button Description
Copy header as text Copies the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Opens a dialog box for editing the report title.

Report Header Shortcuts

Report Features and Shortcuts
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6 About Reports

REPORT TOOLBAR
The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list
box, then click Show.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

Field or Button Description
Default Style [button] Specifies default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button] Displays the Print window for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button] Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Report Toolbar
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TABULAR REPORT FEATURES AND SHORTCUTS
Display tabular report shortcuts by right-clicking in the body of the tabular report. Column
shortcuts require right-clicking on the column to be modified.

Field or Button Description
Align column Changes the column alignment to either left, right, or centered.

Copy table as text Copies the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Edits the report title and/or title font attributes. Click Font to modify
font attributes.

Move column Right-click the column to be moved. SelectMove column on the short-
cut menu and select Left or Right for the move.

Rename column Right-click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column Right-click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right-click in the report data. Select Table data font on the shortcut
menu.

Table header font Right-click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Tabular Report Shortcuts

Report Features and Shortcuts
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GRAPH FEATURES AND SHORTCUTS
Right-click in the graph area to display graph report shortcuts.

Field or Button Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy data Copies the report data to the clipboard. It can then be pasted into
other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Copy graph Copies the graph to the clipboard. It can then be pasted into other
software programs.

Edit axis Edits the selected axis properties.

Gridlines. Changes how to display major / minor grid lines.

Scale.

n Autoscale minimum/maximum. To manually specify minimum /
maximum autoscale, deselect the option and enter the new
amount in the text box.

n Invert scale. Inverts the scale.
n Linear/Logarithmic. Scales the graph as linear or logarithmic.
n Scale font. Modifies the font for the scale label. Deselect Use

default font to enable font options.

Title. Edits the selected axis label.

Title font.Modifies the font for the selected axis label. Deselect Use

Graph Shortcut Options
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Field or Button Description
default font. Select new font attributes for report data. Enable Use
default font to reset default fonts.

Edit curve Edits selected curve properties.

Color. Changes the curve color.

Curve. Changes the interpolation, point style, and pen style for the
selected curve. These options are disabled if Use default fill style is
selected in the Histogram group box.

Histogram. Enabled only if Histogram is selected in the Style drop-
down list. Specifies the type of fill, fill color, and label position for the
selected curve.

Label. Designates where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Style. Selects another style for the collected data curve.

Title. Changes the title of the selected curve.

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.

Graph Shortcut Options (continued)

Graph Features and Shortcuts
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6 About Reports

Field or Button Description
Edit legend Changes the legend location and font.

Edit title Changes the report title.

Enable overlays If overlays have been selected, this option displays (or hides) the
overlays.

Include report When selected, places a checkmark to the left of the report in the
Select Reports list box on the Report Options tab.

Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Select overlays... Displays the option to select files to overlay onto the active graph. To
view the overlays, click Enable Overlays on the shortcut menu.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Graph Shortcut Options (continued)
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AXIS CROSS-HAIR
Left-click on the graph to view the cross-hair coordinates.

Example of Axis cross-hair feature

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal
view, right-click in the graph and select Autoscale all axes.

Graph Features and Shortcuts
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6 About Reports

GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.

Field or Button Description
Grid Line Styles
[selection]

Select if the major and/or minor grid lines should appear as solid or
dotted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the log-
arithmic and linear scales. Deselect this option to remove the grid
lines.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Graph Grid Lines
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GRAPH AND SAMPLE OVERLAYS

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

Use the graph overlay functions to compare multiple graph options. Graphical lines are
differentiated by the use of varying colored symbols outlined on a legend. Overlays may be
generated in two ways:

n Multiple Graph Overlays.Overlay two different types of graphs from one sample.
n Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot. This

type of overlay is available only for:

o BJH Adsorption / Desorption
o DFT Pore Size / Surface Energy
o Dollimore-Heal Adsorption / Desorption
o Horvath-Kawazoe
o M-P Method

This feature is available only when using Advanced option presentation. Go to
Options > Option Presentation > Advanced.

Graph and Sample Overlays
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6 About Reports

OVERLAY MULTIPLE SAMPLE FILES

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

To overlay the same type of graph on multiple samples:

1. Go to File > Open.
2. Select a .SMP file, then clickOpen. If the Isotherm plot displays, select Advanced from the

view selector drop-down list at the bottom of the window to display the tabbed window view.
3. Click the Report Options tab.
4. In the Selected Reports list box, highlight a report then click Edit. Use the following table to

complete the process for the selected report.
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If overlaying this type of
report...

Then...

n Isotherm

a. On the Isotherm Report Options window, select one or
more plots in the Selected Reports group box, then click
Options to the right of the selected plot.

b. On the Plot Options window, select Plot curve and/or Plot
points if they are to be included in the overlay. If the x-
and/or y-axes are to be autoscaled, enable Autoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.

c. On the Isotherm Report Options window, in the Plot
Options group box, select Plot overlays. ClickOK.

d. Continue to Step 5.

n Alpha-S Method
n BET Surface Area
n f-Ratio Method
n Freundlich
n Langmuir Surface Area
n t-plot
n Temkin

a. On the pop-up window, selectOverlay samples. Verify
other fields. ClickOK.

b. Continue to Step 5.

n BJH
n Dollimore-Heal
n MP-Method

a. Select the report variable from the Selected Reports
group box, then click Edit.

b. Click the down arrow on theOverlay field, then select the
Samples option.

c. Verify other fields.
d. ClickOK.
e. ClickOK again.

5. On the Report Options tab, clickOverlays.
6. On the Plot Overlay Sample Selection window, move up to 25 files from the Available Files

box to the Selected Files box:

7. ClickOK.
8. To view the report, click Preview.

Overlay Multiple Sample Files
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6 About Reports

Field Description
Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then click Add. The selected files are moved to the Selected
Files list box.

Look in [button] Click the Browse icon to change the file folder location.

Selected Files
[selection]

Lists the files selected to be combined. ClickOK to combine the files.

Status [drop-down box] Select the status of files to be combined.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Overlay Sample Selection
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REPORT EXAMPLES

BJH ADSORPTION REPORT

Report Examples
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6 About Reports

HORVATH-KAWAZOE REPORT
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ISOTHERM LINEAR PLOT REPORT

Isotherm Linear Plot Report
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6 About Reports

SAMPLE LOG REPORT
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T-PLOT REPORT

t-Plot Report
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6 About Reports

VALIDATION REPORT
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7 SELECTED REPORT OPTIONS

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

7 Selected Report Options
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7 Selected Report Options

ALPHA-S METHOD REPORT

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using
the quantity adsorbed at a relative pressure of 0.4.

One predefined curve is located in the Reference file directory. Use the table buttons to enter
relative pressure and the Alpha-S values.

Field or Button Description
Open [button] Use to import values from an existing thickness curve (.ALS).

The table to be imported must be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columns must be separated by a space or a tab.

Alpha-S Method Report
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Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used
to calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimum and maximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot. Use to plot data in graph format.
n Autoscale x-axis. The x-axis field shows the relative pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the plot.
Tabular Report. Use to have a tabular report of data generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Alpha-S Method Report (continued)

Alpha-S Method Report
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7 Selected Report Options

BET SURFACE AREA REPORT

The BET calculation obtains the sample surface area value by determining the monolayer
capacity of adsorbed gas from the isotherm data. BET uses a multilayer model.

Field or Button Description
Pressures [button] This option is available when the sample file has a status of Ana-

lyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table if not using the Use
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.

BET Surface Area Report
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Field or Button Description
Include All. Select to include all pressure points in the table.

Insert Predefined. Click to insert a predefined (default) set of points
into the report. Use Interpolationmust be selected to enable this
button. This button displays for BET reports only.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for BET fit [text box]

Enter values to indicate the fitted pressure range.

Selected Reports
[group box]

BET Isotherm plot. Uses BET monolayer capacity and constant to
produce an isotherm.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples. Use to overlay sample files on the
BET isotherm plot.

BET Transform plot. Use to generate a traditional BET surface
area plot used to determine monolayer volume and BET C constant.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

n Autoscale y-axis. The y-axis field shows BET transformation.
n Overlay samples. Use to overlay sample files on the

BET transform plot.

Tabular report. Use to have a table of measured and calculated
values generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

BET Surface Area Report (continued)

BET Surface Area Report
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7 Selected Report Options

BJH ADSORPTION/DESORPTION REPORT

The BJH calculation determines the mesopore volume/area distribution, which accounts for both
the change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be
generated from both adsorption and desorption data. The fields for both BJH Adsorption Report
Options and BJH Desorption Report Options are identical unless otherwise specified.

An incomplete pore distribution may be generated if a thickness curve selection is not
a good match for the sample being analyzed.

Circled selection is applicable to BJH
Adsorption only

Field or Button Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

BJH Adsorption/Desorption Report
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Field or Button Description

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected
type will display in the report header.

Faas.Good for statistical thickness curves.

Kruk-Jaroniec-Sayari.Good for reference thickness curves.

Standard. Uses original BJH models.
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that
all pores are closed at one end. Occasionally, a percentage of pores
may be open at both ends causing disagreement in the adsorption
and desorption data or in the values for total volume and total BJH
pore volume. Enter the fraction of pores open at both ends to
compensate for this error.

BJH Adsorption/Desorption Report (continued)

BJH Adsorption/Desorption Report
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7 Selected Report Options

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

BJH Adsorption/Desorption Report (continued)
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Field or Button Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

BJH Adsorption/Desorption Report (continued)

BJH Adsorption/Desorption Report
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7 Selected Report Options

BJH PLOT

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then
click Edit.

Field or Button Description
Autoscale [check box] When enabled on the report parameters windows, allows the x- and

y- axes to be scaled automatically. Autoscalemeans that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box] Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box] Overlay. Select an option to overlay onto the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

BJH Plot Report
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BJH TABULAR REPORT

Highlight BJH Tabular Report in the Selected Reports list box on the BJH Adsorption Report
Options window, then click Edit to specify the method of data reduction.

Field or Button Description
Collected points
[selection]

Use to include all relative pressure points collected. Refer to the
Columns button below.

Columns [button] Select the data types to include in the report. Column [n] indicates
the column order and data contents for the report.

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. Click Table
to modify the fixed pore size table. Refer to Table and Columns but-
tons elsewhere in this table.

Table [button] The fixed pore size table must contain a minimum of two points. The
points must be strictly decreasing. Enabled only when Fixed pore
size table is selected.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

BJH Tabular Report

BJH Adsorption/Desorption Report
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7 Selected Report Options

DFT PORE SIZE REPORT

The DFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro and mesopore ranges.

Field or Button Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

DFT Pore Size Report
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Field or Button Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Reports
[group box]

Select the reports to generate. To edit graph details, highlight the
graph option and click Edit. The Log Goodness of Fit andGoodness
of Fit graphs cannot be edited.

Autoscale Options. Use to autoscale the x-axis and/or y-axes.

Axis Range. From/To fields are enabled when Autoscale options
are not selected. Enter the starting and ending values for the x-
and/or y-axes.

n x-axis. Shows the pore size.
n y-axis. Shows the area.

Overlay. Select an overlay for the report.

Plot Type. Select the method for data display.

DFT Pore Size Report (continued)

DFT Pore Size Report

Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021 7 - 13



7 Selected Report Options

Field or Button Description
Type [drop-down box] Classical.Model based on the Kelvin equation and thickness for

determining the pore size distribution. See DFT Models on page B -
1.

DFT.Model based on the density functional theory.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

DFT Pore Size Report (continued)

DFT SURFACE ENERGY REPORT

DFT Pore Size Report on page 7 - 12

The DFT Surface Energy report contains the results of surface energy distribution analyses.

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report
Options.
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DOLLIMORE-HEAL ADSORPTION/DESORPTION REPORT

BJH Adsorption/Desorption Report on page 7 - 6 for additional information on field and
buttons for this report.

The Dollimore-Heal Adsorption Report Option and the Dollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

Field or Button Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Dollimore-Heal Adsorption/Desorption Report

Dollimore-Heal Adsorption/Desorption Report
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7 Selected Report Options

Field or Button Description
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

Dollimore-Heal Adsorption/Desorption Report (continued)
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Field or Button Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Dollimore-Heal Adsorption/Desorption Report (continued)

Dollimore-Heal Adsorption/Desorption Report
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7 Selected Report Options

DOLLIMORE-HEAL DESORPTION PLOT OPTIONS

BJH Plot on page 7 - 10

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the Dollimore-Heal Report Options
window, then click Edit. The fields and buttons for these reports are identical to the BJH Plot
Report Options.
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DOLLIMORE-HEAL TABULAR REPORT OPTIONS

BJH Tabular Report on page 7 - 11

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options.

Dollimore-Heal Adsorption/Desorption Report
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7 Selected Report Options

DUBININ REPORT

The Dubininmethod provides pore volume distributions for microporous materials by making use
of an expression for the adsorption potential.

Field or Button Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Fitted Relative
Pressure Range
[group box]

Enter the minimum and maximum limits for Radushkevich or Astak-
hov relative pressures included in the line fit.

Dubinin Report
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Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Report Type
[group box]

Select report types. If Astakhov is selected, either selectOptimize
exponent or enter an appropriate exponent value in the text box.

Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Dubinin Report (continued)

Dubinin Report
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7 Selected Report Options

DUBININ PORE VOLUME REPORT OPTIONS

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list
box, then click Edit.

This option plots differential pore volume as a function of pore width.

Field or Button Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Enable to enter beginning and ending values manually.
Overlay samples
[selection]

Use to overlay sample files on the plot.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Dubinin Pore Volume Report
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DUBININ TABULAR REPORT OPTIONS

In the Dubinin Report Options window, highlight Dubinin Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

Log (po/p )^n. The value for [n] is the optimized exponent ifOptimize exponent is selected on the
Dubinin Report Options window. If not, then the value for [n] is the entered exponent value.

Dubinin Report
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7 Selected Report Options

DUBININ TRANSFORMED ISOTHERM PLOT OPTIONS

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options
window, then click Edit.

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lines when transformed in this way.

Field or Button Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending values manually.

Autoscale x-axis. Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis. Shows the log of relative pressure.
Overlay samples
[check box]

Use to overlay sample files on the plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Dubinin Transformed Isotherm Plot Report
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F-RATIO METHOD REPORT

The f-Ratio report uses the measured isotherm and normalizes it using a reference isotherm.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

f-Ratio Report

f-Ratio Method Report
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7 Selected Report Options

Field or Button Description
Reference isotherm
[group box]

Browse to select a sample file to use as a reference for the isotherm.
Select a file containing an isotherm measured from a non-porous
sample of the same material as the current sample.

Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

f-Plot. Use to generate a normalized isotherm.

n Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples. Use to overlay sample files on the f-plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

f-Ratio Report (continued)
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FREUNDLICH REPORT

The Freundlich Isotherm is an empirical isotherm used to model low pressure adsorption data. It
can also be applied to model some micropore isotherms. In the Selected Reports list box, highlight
Freundlich, then click Edit.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Freundlich Report

Freundlich Report

Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021 7 - 27



7 Selected Report Options

Field or Button Description
Select Reports
[group box]

Freundlich Isotherm plot. Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

n Autoscale y-axis. y-axes begin at zero. The y-axis field shows
the quantity of gas adsorbed.

n Overlay samples. Use to overlay sample files on the Freundlich
isotherm plot.

Freundlich Transform plot. Plots the log(P) vs log(Q) and the best
fit.

n Autoscale x-axis. The x-axis field shows the absolute pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the Freundlich

transform plot.

Tabular report. Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter the monolayer capacity of the sample.

Tabular report
[selection]

Use to have a report of the pressure points generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Freundlich Report (continued)
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HORVATH-KAWAZOE REPORT

The Horvath-Kawazoemethod plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

Field or Button Description
Apply Cheng-Yang
correction [selection]

Use to apply the Cheng-Yang correction to the pore size analysis.
This correction substitutes the Langmuir equation of state for Henry’s
Law in the Horvath-Kawazoe derivation.

Interaction Parameter
[group box]

Use to determine which interaction parameter will be used in the
report. These options are disabled if Sphere is selected in the Pore
Geometry group box.

Computed. Use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click Properties to display
the Physical Properties window). The interaction parameter is
recalculated each time a parameter in the Physical Properties
window is edited.

Entered. Calculates using the value entered in the text box.
Pore Geometry
[group box]

Select the option that best represents the physical geometry of the
micropores in the sample material. When Sphere is selected, options
in the Interaction Parameter group box are disabled.

Horvath-Kawazoe Report

Horvath-Kawazoe Report
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7 Selected Report Options

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Properties [button] Click to view or edit the constants describing the physical properties

of the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the sample. *
n Description. Select the name of the sample used in the analysis.
n Diameter. Enter the diameter of the sample atom.
n Diameter at zero energy. Enter the diameter of an atom at zero

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility. Enter the magnetic susceptibility of the

sample. *
n Polarizability. Enter the polarizability of the sample. *
Adsorptive. Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the adsorptive. *
n Diameter. Enter the diameter of the gas phase atom.

Horvath-Kawazoe Report (continued)
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Field or Button Description

n Diameter at zero energy. Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 × diameter.

n Magnetic susceptibility. Enter the magnetic susceptibility of the
adsorptive. *

n Mnemonic. Select the mnemonic of the adsorptive gas in use.
n Polarizability. Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports
[group box]

Select the types of reports to generate. Highlight the report, then
click Edit to modify report parameters.

Smooth differentials
[selection]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Horvath-Kawazoe Report (continued)

Horvath-Kawazoe Report
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7 Selected Report Options

HORVATH-KAWAZOE PLOT
See BJH Plot on page 7 - 10 for additional information on fields and buttons for this report.

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options
window, then click Edit to customize the plotting method.

HORVATH-KAWAZOE TABULAR REPORT

Highlight H-K Tabular Report in the Selected Reports list box in the Horvath-Kawazoe Report
Options window, then click Edit. Select the data types to include in the report. Column [n]
indicates the column order and data contents for the report.
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ISOTHERM REPORT

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

Field or Button Description
Options [button]  Click to display related linear plot options. All plot windows contain

identical fields.

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points. Select to plot points on the graph.
Plot Options [group box] Select the types of isotherm to plot.

Quantity Adsorbed
[group box]

Select how to report the quantity adsorbed.

n per gram (cm3/g) STP
n per BET Surface Area (cm3/m2) STP or mmol/g
n per other Surface Area (cm3/m2) STP or mmol/m2

Isotherm Report

Isotherm Report
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7 Selected Report Options

Field or Button Description
Selected Reports
[group box]

Select each option to include on the final report. Click the Options
button of a selected item to include plot curve, plot points, and to
autoscale x- and y-axes.

Tabular Options
[group box]

Select the options to include on the report.

Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter the mass percentage when plotting pressure
composition.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Isotherm Report (continued)
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LANGMUIR REPORT

The Langmuir calculation determines the surface area of a sample by relating the surface area to
the volume of gas adsorbed as a monolayer. Langmuir uses a single layer model.

Field or Button Description
Pressures [button] This option is available when the sample file has a status of

Analyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table. To exclude a point from
the calculations used to generate the report, select Exclude.

Langmuir Report

Langmuir Report
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Field or Button Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for Langmuir fit
[group box]

Enter values to indicate the fitted pressure range.

Select Reports
[group box]

Langmuir Isotherm Plot. Uses the Langmuir monolayer volume
and constant to produce an isotherm.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure for Langmuir.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples. Use to overlay sample files on the Langmuir
isotherm plot.

Langmuir Transform Plot. Use to generate a traditional Langmuir
surface area plot used to determine monolayer volume constant.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure for Langmuir.

n Autoscale y-axis. The y-axis field shows Langmuir trans-
formation.

n Overlay samples. Use to overlay sample files on the Langmuir
transform plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Langmuir Report (continued)
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MP-METHOD REPORT

TheMP-Method Report provides pore volume distributions for microporous materials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go
to Options > Units to specify the unit.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

MP-Method Report

MP-Method Report
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7 Selected Report Options

Field or Button Description
Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

MP-Method Report (continued)
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MP-METHOD PLOT REPORT
In theMP-Method Report Options window, highlight a plot option in the Selected Reports list box,
then click Edit to customize the plotting method.

Field or Button Description
Overlay [drop-down box] Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

X-Axis [check box] Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box] Autoscale. Use to have the y-axis autoscaled or enter beginning
and ending values.

Overlay. Select an option to overlay on the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

MP Method Plot Report

MP-Method Report
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MP-METHOD TABULAR REPORT
In theMP-Method Report Options window, highlightMP Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

The MPMethod reports hydraulic radius only. If Pore size in diameter is selected on
the Unit Selection window, pore size in radius will be reported.
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OPTIONS REPORT

Lists the conditions used to perform the analysis such as:

n Adsorptive properties
n Analysis conditions
n Analysis method
n Degas conditions
n Free space
n Saturation pressure (P0) and temperature

Options reports cannot be edited.

Options Report
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SAMPLE AUDIT TRAIL REPORT

For 21CFR11 environments only.

This report lists all changes and comments that have been applied to sample files with a Complete
status.

SAMPLE LOG REPORT

Sample Log reports cannot be edited.

Inserts a log of sample operations in the reports.

This report provides information on:

n Manual control operations performed during analysis.
n Information entered using Add Log Entry on the sample file editor.
n Warnings and/or errors which occurred during analysis.
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SUMMARY REPORT

The Summary Report for physisorption analyses provides a condensed summary of selected data
results.

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Field or Button Description
Item [n] [selection] Use to enable the first Pass/Fail item. Until the Summary Report is

selected, S A Single-point BET will be displayed by default. When
selected, click Pass/Fail, then select pass/fail criteria options.

Pass/Fail [n]. Click to display the Pass/Fail Options window for
selection of pass/fail criteria.

S A: Single-point BET. Use to enable Pass/Fail [n] in the Item [n]
group box.

Upper/Lower. Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right of Upper / Lower, enter operator instructions to
be displayed if a failure is encountered.

Summary Report

Summary Report
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Field or Button Description
Select All / Deselect All
[button]

Selects (or deselects) all options.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Summary Report (continued)
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T-PLOT REPORT

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves
to be a valuable way of characterizing complex mixed materials.

Field or Button Description
Fitted thickness range
[text box]

Enter the minimum and maximum thicknesses (in angstroms or nano-
meters) to include in the thickness curve. Go toOptions > Units to
specify default units.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

t-Plot Report

t-Plot Report
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Field or Button Description
Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

t-Plot. Use to have a graphical representation of data generated.
n Autoscale x-axis. The x-axis field shows the statistical thickness

of the adsorbed film.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the t-plot.

Surface area correction
factor [text box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area and micropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
the most commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

t-Plot Report (continued)
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Field or Button Description
To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

t-Plot [check box] Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples. Use to overlay sample files on the t-plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

t-Plot Report (continued)

t-Plot Report
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TEMKIN REPORT

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly
with increasing coverage.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Temkin Report

7 - 48 Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021



Field or Button Description
Select Reports
[group box]

Tabular Report. Generates a tabular report of the included samples
that contains the numeric values contributed by each sample.

Temkin Isotherm plot. Overlays the Temkin isotherm with the
analysis data.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

n Autoscale y-axis. y-axes begin at zero. The y-axis field shows
the quantity of gas adsorbed.

n Overlay samples. Use to overlay sample files on the isotherm
plot.

Temkin Transform plot. Plots a linear form of the Temkin
transform plot.

n Autoscale x-axis. The x-axis field shows the logarithm of pres-
sure (ln).

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples. Use to overlay sample files on the transform
plot.

Specify differential heat
of adsorption
[check box]

Select and enter the differential heat of adsorption at zero surface
coverage. This allows inclusion of all Temkin constants.

Specify monolayer
capacity [check box]

Select and enter the monolayer capacity of the sample.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Temkin Report (continued)

Temkin Report
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VALIDATION REPORT

This report allows data to be examined by the analysis program to determine if the results are
within typical ranges. If the data for any reports selected for validation are determined to be out of
range, a warning will display and suggestions are given for corrective action.
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8 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start diagnostic tests, and open saved diagnostic reports.
Each test generates a file to the default directory name and path of ...\...\Service\userdiag unless
another directory name was specified. These reports can be sent to a Micromeritics Service
Representative for examination.

START DIAGNOSTIC TEST
Unit [n] > Diagnostics
Provides a method to start a diagnostic test immediately. Upon completion of the diagnostic test,
the file is saved as a .REP file which can be retrieved by going to Reports > Open Report and
selecting the report file.

Use to clean and verify gas lines when connecting or changing a gas. See Clean and Verify the
Gas Line on page 10 - 8 for detailed instructions. Also used to perform diagnostic tests
requested by a Micromeritics Service Representative.

This option is typically used and /or requested by a Service Representative. These tests create
and save files to the ...\...\Service\userdiag directory. The Micromeritics Service Representative
may request an emailed or faxed copy of the file for diagnostic purposes.

8 Diagnostics
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8 Diagnostics

Field or Button Description
Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.) Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.

Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.

Repeat [button] Repeats the selected diagnostic test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 2.

Start Diagnostic Test
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9 CALIBRATION
Unit [n] > Calibration

A calibration file was created specifically for the analyzer and included with the
accessories. It is not necessary to recalibrate the system unless it seems out of
calibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go to Unit [n] > Unit Configuration.

Generally, it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

9 Calibration
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9 Calibration

BALANCE SERVO VALVE
Unit [n] > Calibration > Balance Servo
Use to calibrate the servo valve to the manifold pressure transducer. The servo valve should
always be recalibrated after a pressure calibration has been performed. The pressure transducer
should be calibrated before starting this calibration procedure.

Ensure the pressure transducer has been calibrated before performing this pro-
cedure. Go to Unit [n] > Unit Configuration and view the calibration information.
Contact your Micromeritics Service Representative if calibration dates are not listed.

Click Start. The window closes when the calibration is complete. Click Cancel to stop the
calibration process.
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MATCH TRANSDUCERS
Unit [n] > Calibration > Match Transducers

This process should not be performed when the main transducer reading is abnormal.

This option is disabled for the Gemini 2390a model.

Use to evacuate the system and zero the pressure transducers, then adjust the scale to match
them to the manifold transducer near full scale pressure.

A blank sample tube or small plug must be installed on each selected port prior to start-
ing this process.

1. Install a blank sample tube or small plug on each port.
2. Click Start. The window closes when the operation is complete. ClickOK when the process

is complete.

Match Transducers
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9 Calibration

ZERO PRESSURE
Unit [n] > Calibration > Zero Pressure
This procedure evacuates the system and zeroes the pressure transducers. This calibration
should only be performed by qualified service personnel. In order to perform this procedure,
sample tubes must be attached to each port.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then click Start. ClickOK when the pro-

cess is complete. The current pressure readings and operation status messages display.
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SAMPLE SERVO VALVE
Unit [n] > Calibration > Sample Servo

Unit [n] > Calibrate Analysis > Sample Servo
Use to calibrate the servo valve to the sample transducer. The servo valve should always be
recalibrated after a pressure calibration has been performed. The pressure transducer should be
calibrated before starting this calibration procedure.

Ensure the pressure transducer has been calibrated before performing this pro-
cedure. Go to Unit [n] > Unit Configuration and view the calibration information.
Contact your Micromeritics Service Representative if calibration dates are not listed.

Click Start. The window closes when the calibration is complete.

Click Cancel to stop the calibration process.

Sample Servo Valve
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9 Calibration

LOAD CALIBRATION FROM FILE
Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration
file, a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten
each time a new one is created.

Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number
2013-04-25 Date the calibration file was saved
.CAL File name extension
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10 TROUBLESHOOTING
The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.Micromeritics.com).

n Error Messages document (PDF)
n Parts and Accessories
n Smart VacPrep Operator Manual (PDF)
n Vacuum Pump Guide (PDF)

Most operational problems are caused by:

n Leaks (commonly found at the sample tube O-ring at the analysis port)
n Sample weighing errors
n Use of too much analysis bath fluid in the Dewar at the start of an analysis
n Entry of incorrect system volume for analysis
n Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided
below:

Elevator cannot be raised or lowered.

Cause: Dewar elevator stuck.

Action: Check for possible obstruction to elevator movement.

Elevator is noisy.

Cause: The elevator screw may need greasing.

Action: Contact your Micromeritics Service Representative.

Expected results are not within range.

Cause A: Sample improperly degassed.

Action A: Verify that the degassing temperature and degas time were set properly.

Cause B: Gas cylinder(s) may be almost empty - causing gas impurity.

10 Troubleshooting
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10 Troubleshooting

Action B: Replace gas cylinder. See Replace a Gas Cylinder on page 10 - 11.
Cause C: Undetermined.

Action C: Do the following:

1. Perform an empty tube analysis. See Perform a Leak Test on
page 10 - 15 and print the results.

2. Perform a reference material analysis. See Perform a Reference
Material Analysis on page 5 - 16 . Print the results.

3. Contact your Micromeritics Service Representative.

Specified pressure not reached.

Cause A: Sample or balance tube not properly attached.

Action A: Reattach sample and balance tubes. Ensure both are securely attached to
ports. Replace O-rings if defective. See Sample Tube O-ring Replacement
on page 10 - 25.

Cause B: Leak in gas line.

Action B: Perform the Adsorptive and Helium Line tests to determine if a leak exists.
See Diagnostics on page 8 - 1.

Unable to reach a satisfactory vacuum.

Cause A: Vacuum pump oil level is low or needs to be changed.

Action A: Inspect the oil to see if it is low or needs changing.

Cause B: Vacuum pump is leaking.

Action B: Locate and repair the source of the leak or replace pump.

Cause C: Centering ring has become too flat and unable to hold a vacuum.

Action C: Check the centering ring at the pump intake port. Also check the centering
ring at the top of the oil vapor trap. Replace if necessary.

Nitrogen or helium drained from tank, or depleted in a short period of time.

Cause: Leak in the gas line connection.

Action: Perform the Adsorptive (or Helium) Line test to determine the location of the
leak. See Diagnostics on page 8 - 1.

Unit does not work when powered ON.
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Cause A: Power cord not fully inserted at one end.

Action A: Insert power plug firmly into power source and analyzer power connecter.

Cause B: No power at outlet.

Action B: Plug in another electrical device to test the outlet. If there is no power, contact
an electrician.

Cause C: Plug prongs bent so that contact not made at outlet.

Action C: Gently move power plug at outlet while watching power indicator light. If the
indicator light comes on, have electrician replace outlet or plug.

Cause D: Power cord damaged.

Action D: Have electrician check cord using a test meter. Replace the cord if defective.

Cause E: Loose internal connection or broken wire.

Action E: Call a Micromeritics Service Representative for repair or replacement inform-
ation.

Valves cannot be operated.

Cause: Cable from computer to the instrument is loose.

Action: Reconnect the cable.

Vacuum pump is noisy.

Cause A: Sample tube connector is loose.

Action A: Tighten fitting. Replace O-ring.

Cause B: Sample tube O-ring is worn or cracked.

Action B: Replace O-ring. See Sample Tube O-ring Replacement on page 10 - 25.
Cause C: Sample tube is cracked.

Action C: Replace with new sample tube.

Cause D: No sample tube loaded on a selected port.

Action D: Install plug or empty sample tube.

Cause E: Gas inlet valve open while vacuum valve open.

Action E: With manual control enabled, use the instrument schematic to close gas inlet
valve.

10 Troubleshooting
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10 Troubleshooting

PARTS AND ACCESSORIES
Parts and accessories can be found online at www.Micromeritics.com.

POWER

The Gemini VII 2390 is designed to operate with a universal input power supply (100-240VAC) at
50/60Hz. Noise-free power of the correct voltage and frequency, with a safety earth ground,
should be available through a standard wall receptacle. The power outlet should be able to supply
15 amps@ 100 or 110VAC ±10% or 7.5 amps@ 230VAC ±10%. These requirements can be
checked by using a voltage meter (available at most hardware or electronic supply houses) or a
multimeter. There should also be sufficient outlets for the computer, monitor, printer, and any
other peripheral devices.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the specifications stated above.
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SAFE SERVICING

Do not modify this instrument without the authorization of a Micromeritics service per-
sonnel.

To ensure safe servicing and continued safety of the instrument after servicing, service personnel
should be aware of the following risks:

Product specific risks that may affect service personnel:

n Electrical. Servicing or repair could require opening the outer panels and exposing ener-
gized electrical components.

n Liquid nitrogen. See Dewar Precautions on page 5 - 1.
n Elevator. Could pose a pinching hazard when lowering. Maintenance may require the elev-

ator screw to be greased. The service engineer can use a manual switch on the elevator
assembly to cycle the elevator to distribute the grease to permit safe servicing and con-
tinued safety of the equipment after servicing.

Protective measures for these risks:

n Electrical. The majority of electrical components operate at low voltage (24V or less) and
pose low risk when energized. Maintenance, troubleshooting, and repairs should be per-
formed with the instrument de-energized whenever possible, in accordance with standard
electrical safety guidelines.

n Elevator. Moves very slowly. It is normally operated from the computer attached to the
instrument so the operator is physically distanced from the instrument. The safety shield
door of the instrument should be closed during elevator operation. Use of the manual switch
on the instrument requires particular attention and care by the service personnel.

Verification of the safe state of the instrument after repair:

n Elevator must be in the down position.
n Sample tubes must be removed to prevent accidental breakage. Ports should be capped

(recommended).
n Safety shield door is closed (recommended).

Safe Servicing
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10 Troubleshooting

GUIDELINES FOR CONNECTING GASES

These instructions refer to the installation of a gas line, regulator, and gas cylinder for
each type of gas used. Expansion kits or other accessories may be used in the lab. If
so, special consideration should be given to these configurations when installing the
gas lines.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage the instrument. Always refer to the MSDS when
handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

n Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders
close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure. Gas lines are typically five to six feet long.
Long gas lines, such as those used with gas cylinders placed in remote areas, must be
evacuated for an extended period of time to remove ambient gases. When possible, avoid
placing gas cylinders in remote locations. It is always best to have gas cylinders located near
the analyzer

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines

are used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as
those with a herringbone covering, but the line may be coated internally with a polymer.
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n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.

n Label the gas line at the analyzer inlet for proper identification and maintenance.
n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-

sure reads approximately 500 psi (3500 kPa) on the high pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

n Ensure the gas cylinder is closed before connecting to the analyzer.

Guidelines for Connecting Gases
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10 Troubleshooting

CLEAN AND VERIFY THE GAS LINE

Unit [n] > Diagnostics
Always clean the gas lines and verify there are no leaks at the connections after a gas cylinder is
connected. This test examines the gas line from the analyzer to the gas cylinder, then from the
analyzer to the regulator shut-off valve. A report is generated at the completion of the test to verify
that it has passed or failed. Causes and corrective action for a failure are provided.

Before beginning, confirm that the state for valves and the low pressure gauge are as follows:

A. Gas tubing to instrument
B. Gas regulator shut-off valve -

OPEN
C. Low pressure gauge - 14-15

psig
D. High pressure gauge
E. Gas cylinder shut-off valve -

CLOSED
F. Regulator connecter nut
G. Regulator control knob -

OPEN
H. Brass reducer fitting

1. Click the down arrow to the right of the Test field and selectGas Line Clean and Verify #
Rev [n]. This procedure uses the analysis gas as an example. Select Clean and Verify
Helium Gas Line Rev [n] if the helium cylinder is being verified.

2. Select Report after test and select Preview as the destination. Resize the window if this
option does not display.

3. Click Start. From the View drop-down list, select eitherOperation, Instrument Log, or Instru-
ment Schematic.
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4. A series of prompts display requiring operator response. The length of time a test will run is
also indicated.

5. A popup window indicates the test is complete. ClickOK.
6. Click the Instrument to Regulator Shut-off Valve -1 tab to display its report.

The Leak Rate field should read Passed indicating the gas line from the analyzer to the
regulator is clean and leak-free.

If the Leak Rate field indicates Failed, a leak is indicated. Check the connections from the
analyzer to the gas regulator valve. Tighten as necessary, then run the test again.

7. Click the Instrument to Gas Bottle Shut-off Valve - 2 tab to display its report.

The Leak Rate field should read Passed indicating the gas line from the analyzer to the
regulator is clean and leak-free.

If the Leak Rate field indicates Failed, a leak is indicated. Check the connections from the
regulator shut-off valve to the gas cylinder shut-off valve. Tighten as necessary, then run the
test again.

Clean and Verify the Gas Line
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10 Troubleshooting

8. Click theGas Pressure Test - 3 tab to display its report.

On the report, theMinimum field should read Passed indicating all valves are in the proper
state for operation.

If theMinimum field indicates Failed, one or more valves is not in the proper position. Set
the valves as shown at the beginning of this section and ensure the appropriate pressure is
displayed on the low pressure gauge.

If running the test again, close the gas cylinder valve before starting the test.

9. Click Close to close the test report. Click Close again to close the test.
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REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. When working with
hazardous gases, follow the safety procedures established by your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may
be required.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be
vented from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and

move the cylinder to an appropriate location.

Replace a Gas Cylinder
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10 Troubleshooting

Connect a Gas Cylinder

Analyzer Gauge should indicate
Gemini 15-18 psig (103 - 124 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended air pressure could cause personal injury or
damage the instrument.

Move the replacement cylinder close to the analyzer and tether it into place.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder.

2. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when it is depleted and replaced.

3. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

4. Check for leaks at the high pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high pressure gauge for approximately one minute.

n If the pressure is stable, proceed with the next step.
n If the pressure decreases, tighten the regulator connector nut until it becomes

stable. If the pressure does not remain stable, remove the regulator and clean all
contacts at the regulator connection, then reinstall the regulator.

5. Purge the air from the lines by doing the following:

Purge the regulator before proceeding to prevent contamination of the analysis gas
supply.

a. Open the gas cylinder valve to pressurize the regulator, then close the valve.
b. Adjust the Pressure Control knob to approximately 5 psi.
c. Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both

gauges read approximately zero.
d. Close the regulator Shut-off valve to stop gas flow.
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e. Reconnect the gas line to the regulator.
f. Use two 7/16 in. (11 mm) wrenches to tighten the gas line connection. Hold one wrench

fitting steady and the other to tighten the connector nut.
6. Set the analyzer pressure by doing the following:

a. Turn the Regulator Control knob clockwise until the low pressure gauge indicates the
appropriate pressure. See the Regulator Pressure Settings table in Connect a Gas
Cylinder on the previous page.

b. Open the regulator Shut-off valve.
c. Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.
d. Close the gas cylinder Shut-off valve.
e. Close the gas cylinder valve.

7. If the gas line to the instrument inlet was previously disconnected, reconnect it now.

Replace a Gas Cylinder
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10 Troubleshooting

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

Show Instrument Schematic on page 2 - 17

Use to enable the manual control of certain system valves and pump components on the analyzer
schematic.

When this option is enabled, a checkmark appears to the left of Unit [n] > Enable Manual
Control.

If the analyzer schematic is not immediately visible, go to Unit [n] > Show Instrument
Schematic.
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PERFORM A LEAK TEST
Unit [n] > Diagnostics
AMicromeritics Service Representative may request that a leak test be performed to determine if
there is a system leak and may also require a copy of the report generated by this test.

The test provides:

n Prompts on preparing the analyzer for the test.
n Approximate time period of the test.
n Prompts in which an operator response is required.

1. Select the test to run.
2. Select Report After Test and choose Preview as the destination.
3. Click Start.
4. Verify all tests have a Passed status by selecting the tabs and looking for the Passed status

for each test run.
5. Click Save As to save the test file results.

Perform a Leak Test
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A. Suspend/Resume/
Skip/Play buttons

B. Port report buttons
C. Live graph settings
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PERFORM REFERENCE MATERIAL ANALYSIS
Perform a Reference Material Analysis on page 5 - 16

PERFORM AN EMPTY TUBE ANALYSIS FOR DIAGNOSTIC PURPOSES
An empty tube analysis is a means of pinpointing operational problems in the analyzer. Leaks, as
well as electronic problems, will result in an unsatisfactory blank analysis. This test should be
performed prior to detailed troubleshooting. The data produced during the blank analysis can be
helpful in identifying the cause of a problem and should be performed before contacting a
Micromeritics Service Representative.

Helium is required for performing an empty tube analysis since a measured free space is required.
If helium is unavailable, contact a Micromeritics Service Representative for an alternative method
of performing this procedure.

1. Install empty, straight-wall sample tubes (free of cracks or chips) of the same size in the
sample and balance ports. Ensure the O-rings are in good condition.

2. Place the Dewar support on the elevator, then place a Dewar of water at ambient tem-
perature on the Dewar support. (A Dewar support is not necessary for the larger Dewar
used with the Gemini VII 2390t. Place the Dewar directly on the elevator.)

3. Go to Unit [n] > Empty Tube Analysis.

4. Click Browse and select a file or to create a new one. ClickOpen.
5. Click Edit to make modifications or replace all parameters in the open file using the

Replace All button. Click Save, then click Close.
6. Click Report after analysis to generate reports to specify the report destination when the

analysis is complete. ClickOK.
7. Click Start to begin the analysis. A window displays data as they are collected. A short

delay is encountered before the port status changes from the Idle state at the bottom of the
screen. Review the analysis results to see if they are within the tolerances shown in the fol-
lowing table. If these results are not achieved, call a Micromeritics Service Representative.

Perform Reference Material Analysis
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10 Troubleshooting

P/P0 Tolerance in cm3 STP
0.1 ±0.008

0.2 ±0.010

0.3 ±0.012

0.4 ±0.014

0.5 ±0.016

0.6 ±0.018

0.7 ±0.020

0.8 ±0.022

0.9 ±0.024

10 - 18 Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021



PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required Frequency
Alumina in vapor oil traps * Replace as required.

Analyzer exterior Clean as required or every 3 to 6 months.

Dewar Check and clean weekly.

Diaphragm vacuum pump ** If an oil-free pump is used, replace diaphragm(s) every 12
months.

Dry forepumps As required or every 24 months.

Port filters and O-rings Replace every 3 to 6 months.

Sample tube O-ring Replace as required or every 3 to 6 months.

Test for leaks As required or every 12 months.

Vacuum pump exhaust filter Replace as required or every 12 months.

Vacuum pump fluid * Inspect and change as required or every 3 to 6 months.

* Oil sealed vacuum pumps only.

** For oil-free pumps only: After 12 to 18 months of operation, the diaphragm(s) in the pump will
wear out and the pump becomes completely inoperable. To prevent instrument downtime due
to an inoperable pump, it is recommend that the diaphragm(s) be replaced by a Micromeritics
Service Representative every 12 months.

Preventive Maintenance
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CHECK AND CLEAN THE DEWAR

When handling Dewars, follow the precautions outlined in Dewar Precautions on
page 5 - 1.

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port Dewar.
Particles or deposits exceeding 1/4 in. in depth may jam between the bottom of the sample tube
and the bottom of the Dewar.

Accumulations of fine particles impede liquid nitrogen circulation around the bottom of the sample
tube. This causes the sample temperature to be slightly higher which, in turn, can cause pore
volume measurement errors in those samples exhibiting high isotherm slope above 0.97 relative
pressure.

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen
evaporates. The water must be removed, otherwise it will solidify when liquid nitrogen is added
and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use.
Clean on a weekly basis.

1. Remove the Dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitro-

gen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

3. Rinse the Dewar with warm water to melt any remaining ice accumulation which may
remain. Dry thoroughly.

4. Replace the Dewar.
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CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

n Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in
damage to the unit.

n Use only a mild detergent in water to clean safety shields. The use of isopropyl
alcohol can damage the shield surface.

CLEAN THE GAS DELIVERY TUBES

If using a FlowPrep, gas delivery tubes should be wiped with a clean, lint-free cloth after each use
to remove any particles of sample that may have adhered to the tube. If a gas delivery tube
becomes clogged or damaged, it should be replaced.

1. Remove the gas delivery tube from the flexible tubing.
2. Attach a new gas delivery tube by pressing the flexible tubing over the gas delivery tube.

Ensure that the flexible tubing completely covers the ferrule at the end of the gas delivery
tube.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If
the elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service
Representative for disposition.

Should lubrication become necessary, apply a light coat of Teflon Magnalube-G grease
[Micromeritics part number 004-16163-00] to the elevator screw. Do not grease the guide rods.

Clean the Instrument

Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021 10 - 21



10 Troubleshooting

POWER INSTRUMENT ON AND OFF

DO NOT connect or disconnect cables when the instrument is powered ON.

If a Smart VacPrep is used, it is recommended that the power to the Smart VacPrep remain ON
when the analyzer is powered on. If it does become necessary to power off the Smart VacPrep,
exit the analyzer program first. Restart the analyzer program, then power on the Smart VacPrep.

Power ON the equipment in the following order:

1. Computer, monitor, and printer.
2. Analyzer.
3. External vacuum pump (the pump must warm approximately two hours before performing

analyses).
4. Degasser.

Power OFF the equipment in the following order

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print
manager will print. If a power failure occurs and an uninterruptible power supply (UPS) is
not attached to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

2. Computer, monitor, and printer.
3. Analyzer.
4. External pump.
5. Smart VacPrep.
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SAMPLE PORT FRIT REPLACEMENT

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

A frit is located in the connecting nut attached to each analysis port. If the frit becomes
contaminated, the contaminant may adsorb or desorb during analysis, affecting the results. A
contaminated frit on the analysis port may be indicated as a leak or a free space reading much
lower than normal.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Right click on the valve of the appropriate port. If the valve is open, click Close to close the
valve.

3. Use a wrench to remove the connecting nut from the sample port. Pry out the filter (frit) and
O-ring.

To avoid degassing problems, the frit should be clean and should not be touched with
bare hands.

Sample Port Frit Replacement
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4. Place a new frit into the connecting nut.

A. O-ring
B. Filter (frit)
C. Sample tube fitting

5. Replace the filter and O-ring. Carefully reassemble the sample tube fitting and reinstall on
the sample port. Tighten by hand, then with a wrench to prevent leaks.
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SAMPLE TUBE O-RING REPLACEMENT

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

Do not allow the sample tube connector nut drop onto the bottom of the tube as it may
break the tube.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

1. Carefully remove the Dewar from the analyzer. Take care not to bump the sample tube
bulbs with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand, loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to
grasp the sample tube with both hands.

A. Sample tube or balance tube
B. Connector nut
C. O-ring
D. Ferrule

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

If the O-ring remains inside the sample port, use the O-ring removal tool from the
accessory kit [tool part number 004-54618-00] or use a pair of tweezers or needle-
nose pliers to remove it.

Sample Tube O-ring Replacement
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5. After the new O-ring is in place, insert the sample tube back into the sample port until it is
fully seated.

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule and O-ring will move along with the connector nut). Then, turning clockwise,
hand tighten the connector nut to the sample connector.

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.

OIL-BASED VACUUM PUMP
The Vacuum Pump Guide can be found on the Micromeritics web page (www.Micromeritics.com).
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A ANALYZE SAMPLES WITH A TOTAL SURFACE AREA OF
1.0M2 OR LESS
The unique balanced measurement method used in the Gemini permits small amounts of surface
area to be measured with nitrogen gas that otherwise would be measurable only with krypton. Low
surface area samples often displace many times more nitrogen than they adsorb, especially if
composed of low-density materials of large particle size. The standard, built-in, helium free-space
difference measurement and mathematical compensation routine typically removes the effects of
more than 99% of this sample displacement, but the small amount remaining uncompensated can
still be significant.

A technique for adding a compensating volume with negligible surface area into the balance tube
has been developed. It can reduce the size of the initial imbalance to low levels and allow precise
measurement of adsorbed gas.

This technique can be performed by the following methods:

n Using glass beads in the balance tube
n Using filler rods in the sample and balance tubes

Some users find that a combination of the two methods— using glass beads and filler rods—
produces even better results. This, however, will depend on the type of sample you are analyzing.

Filler rods and glass beads are included in the accessories kit. Either straight-wall or bulb sample
tubes may be used.

USING GLASS BEADS
This method typically produces the best results.

1. Place an appropriate quantity of sample in a clean sample tube.
2. Load a second sample tube of the same size with glass beads that have a total volume

approximately the same as the sample volume.
a. Determine the volume (v) of the sample in cm3:

where

m = mass of sample (g)
ρ = density of sample (g/cm3); if density is unknown, refer to your labor-

atory handbook.

b. Determine the number (n) of glass beads needed to equal the sample volume:

A Analyze Samples with a Total Surface Area of
1.0m2 or Less
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A Analyze Samples with a Total Surface Area of
1.0m2 or Less

where

0.014cm3 = approximate volume of one bead

3. Outgas the sample in the sample tube at an appropriate temperature for an appropriate
amount of time.

4. Install the sample tube (containing the outgassed sample) onto the analysis port and the
sample tube (containing the glass beads) onto the balance port.

5. Specify a one-point measurement (P/P0 = 0.05 to 0.1) so that the initial free-space meas-
urement can quickly be determined; then perform the measurement.

6. Using the measured free space absolute value and the following relationship, determine the
mass of glass beads to remove from (or add to) the balance tube to reduce the free-space
imbalance:

where

2.515 g/cm3 = density of glass beads
3.53 = thermal correction (no units)

Note that the volume of one glass bead is approximately 0.014 cm3. Therefore, if the
measured free space is less than 0.02 cm3, it is unnecessary to correct the free
space.

7. Use a beaker of warm water to bring the balance tube to room temperature before removing
it from the balance port of the Gemini to remove (or add) glass beads. This prevents con-
densation of moisture from the laboratory atmosphere onto the cold glass beads.

8. Remove the balance tube:

n If the measured free space is negative (–), add the calculated mass of glass beads into the
balance tube.

n If the measured free space is positive (+), remove the calculated mass of glass beads from
the balance tube.

9. Reinstall the balance tube onto the balance port of the Gemini analyzer.

For subsequent samples of the same material, use the same mass of sample that was
used for the initial sample so that the original bead quantity may be left undisturbed on
the balance port.

10. Prepare the analysis Dewar and place it on the elevator.
11. Close the sample compartment door and start the analysis.
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USING FILLER RODS
1. Clean the sample tube, balance tube, and filler rods; label your sample and balance tubes.
2. Prepare the sample and place it into the sample tube; insert the shorter filler rod into the

sample tube.

If using bulbous sample tubes, use the same size filler rod as used in the balance tube.

3. Ensure that the filler rods are equidistant from the top of each tube. If they are not, add or
remove sample until they are the same distance from the top of the tube.

Packing of some powders may restrict gas access to the powder and cause slower
equilibration and/or lower results.

4. Attach the sample tube to the analysis port and the balance tube to the balance port.
5. Prepare the analysis Dewar and place it on the elevator.
6. Close the sample compartment door and start the analysis.

A Analyze Samples with a Total Surface Area of
1.0m2 or Less
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A Analyze Samples with a Total Surface Area of
1.0m2 or Less

USING GLASS BEADS AND FILLER RODS
This method may further improve results, depending on the sample material being analyzed.

1. After determining and loading the amount of glass beads to use, insert a filler rod into the
balance tube.

2. Insert a filler rod into the sample tube. Ensure that the filler rods are equidistant from the top
of each tube. If they are not, add or remove sample until they are the same distance from
the top of the tube.

3. If using bulbous sample tubes, use the same size filler rod as used in the balance tube.
4. Attach the sample tube to the analysis port and the balance tube to the balance port.
5. Prepare the analysis Dewar and place it on the elevator.
6. Close the sample compartment door and start the analysis.
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B DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of a model that can be
visualized and described mathematically. Early models of physisorption were quite simple, both
conceptually and mathematically. For very practical reasons, hand computations were required.
Today we can explore complex models that describe adsorption systems on the atomic scale of
size and sub-picosecond time frame. This is not because scientists are smarter, but because of
available tools. The DFT models are created by classical approaches to adsorption as well as
models based on modern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS
Included in this group are methods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND
Traditional adsorption theories attempt to describe experimental adsorption isotherms with an
isotherm equation containing a small number of parameters. At a minimum, these parameters
include the extent of the surface, such as the monolayer capacity (Qm), and the molar intensity of
the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbed molecules
with each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters
for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the
microscopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters,
the pore size, the pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded
over time. In this situation, the pressure falls rapidly from its initial value and gradually
approaches a steady reading, called the equilibrium pressure. The amount adsorbed
corresponds to the quantity of gas effectively removed from the gas phase by the solid
surface. A graph that plots amount adsorbed versus equilibrium pressure is called an
adsorption isotherm.

B DFT Models
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B DFT Models

Under such conditions, the argon atoms that randomly enter the pore space feel the presence
of the solid surface as the action of an external attractive force (the dispersion forces or Van
der Waal’s forces) and spend more time near the surface. As a result, the space near the
surface acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a
function of pressure and the molecular properties of the components of the system, then a
model could be constructed for the adsorption isotherm for the system. Modern physical
chemistry provides several ways to calculate this distribution. All these methods are based on
the fundamental thermodynamic law that such a system adopts a configuration of minimum
free energy at equilibrium. Also needed is a description of the pairwise interaction energy
between atoms, U(s), commonly given by a Lennard-Jones potential:

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptive molecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gas molecules in a
system in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these
are used as reference methods because their results are considered exact.

MOLECULAR DYNAMICS METHOD

In the molecular dynamics method, the position and velocity of individual gas particles are
calculated over time at very short intervals. This method takes into account both the forces acting
between the gas particles themselves and those acting between the gas particles and the atoms
of the simulated surface. As the simulated particles collide with each other and with the surface,
the average concentration of particles in the space near the surface is calculated; this calculation
yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of
each particle in the system using time steps of 10-14 seconds. Although the mathematics are
simple, the number of calculations required for a system of even a few hundred particles is
astronomical and challenges even the fastest computers.
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MONTE CARLO METHOD

In the Monte Carlo method, determination of the system equilibrium distribution begins with an
assumption (which may be only approximate) about the initial configuration of particles in the
system. The system is “equilibrated” through a process of randomly selecting one particle and
conditionally moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and
another particle is randomly selected to be moved.

If the move results in a configuration of higher energy, a probability for that event is calculated,
and a random number between zero and one is generated. If the generated number is smaller
than the probability of the event, then the move is accepted; otherwise, another particle is selected
and the process is repeated. This process continues until the average total energy of the system
no longer decreases; at this point, average configuration data are accumulated to yield the mean
density distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic
simulations and can yield the same results; however, neither method provides a really practical
way to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION
Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo
simulations. When compared to reference methods based on molecular simulation, this theory
provides an accurate method of describing inhomogeneous systems yet requires fewer
calculations. Because the density functional theory provides accuracy and a reduced number of
calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated
by a distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system
of constant density; its chemical potential1 ) is determined by the pressure of the system using
well-known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1 ) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energy with respect to density (or concentration).

Models Based on Statistical Thermodynamics
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B DFT Models

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory
describes the thermodynamic grand potential as a functional of the single-particle density
distribution; therefore, calculating the density profile that minimizes the GPE yields the equilibrium
density profile. The calculation method requires the solution of a system of complex integral
equations that are implicit functions of the density vector. Since analytic solutions are not possible,
the problemmust be solved using iterative numerical methods. Although calculations using these
methods still require supercomputing speed, the calculation of many isotherm pressure points for
a wide range of pore sizes is a feasible task. The complete details of the theory and the
mathematics can be found in the papers listed under DFT Model References on page B - 17.

The following graphs and accompanying text illustrate the results of using density functional
theory to predict the behavior of a model system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure 1. Density Profile for Argon on
Carbon at 87.3 K and a Relative
Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise
distribution of adsorbate; the first monolayer is sharply defined and a third layer can be
distinguished. The area under the profile curve represents the amount adsorbed per unit area at
this pressure. The positions of the maxima are separated by a distance determined by the size of
the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as
the integral over the profile. Repeating this calculation over a range of pressures yields the
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained
corresponds to that of an external, or free, surface. If H is smaller, a range of pressures is reached
where two minima exist for the grand potential, showing the presence of two metastable phases
having different density distributions but the same chemical potential. The phase with the lower
GPE is the stable one. As the pressure is increased, a point is reached where the other phase
becomes the stable one. This phase transition reflects condensation of adsorbate in the pore; the
pressure at which it occurs is called the critical pore-filling pressure. This pressure is analogous to
the condensation pressure predicted by the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for a model pore with H = 40 angstroms.
The inset shows the density profiles for the corresponding points of the isotherm.

Figure 2. Model Isotherm for Argon at
87.3 K in a 40 Å Slit in a Carbon
Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close
to the surface.

n Inset a shows the profile corresponding to point a on the isotherm where the surface is about
half covered.

n At point b, the first layer is so full that it is more favorable for atoms to start a new layer.
n At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In

inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4
or 5 molecular diameters from the surface.

n Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center
of the pore, indicating a phase transition.

Models Based on Statistical Thermodynamics
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B DFT Models

Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point c. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores
are shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-
filling pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.

Figure 3. Model Isotherms for Some
Larger Pore Widths Argon on Carbon at
87.3 K

Figure 4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale
for pressure.

Figure 4. Model Isotherms in the
Micropore Size Range of Pore Width
Argon on Carbon at 87.3 K
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 millitorr.
Pores below 15 Å fill before a monolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been
calculated to serve as kernel functions for the characterization of porous solids from adsorption
data. The model isotherms are stored in binary format files. These models assume a slit-like pore
geometry. The pore size range from 4.0 to 4000 Å is covered in 91 classes in a geometric
progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A model for
the free or external surface is included to account for unfilled pores. Each of the 92 model
isotherms has been calculated at 181 pressure points from near 1×10-6 to near 1.00 relative
pressure.

These models are identical to those supplied with the original DOS version of DFT software.
Some slight difference from the DOS results may be noted when they are applied to the same
data due to improvements in the deconvolution algorithm and better regularization of the current
software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K

Models Based on Statistical Thermodynamics
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Using the modified Tarazona prescription described by Olivier (see DFT Model References on
page B - 17 [items 3 and 4]), model isotherms were calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. The model makes no provision for pore filling in the
micropore region. If the sample solid contains small mesopores, the isotherm data should be
truncated (using the Select Data Points window) to a suitably low relative pressure to avoid trying
to fit this region; mesopore filling reports as a large area of low energy in the calculated distribution
of adsorptive potential.

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as
zeolites. The pore-filling pressures were determined as a function of the pore size from adsorption
isotherms on MCM-41 materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2 model reports pore sizes ranging from 3.8 to 387 Å and the ARmodel from
3.8 to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A NewMethod for the
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Meso-
porous Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference
samples of montmorillionite. The construction method for the hybrid models was analogous to that
described in the first reference below (Jaroniec et al,1999). The additional references add
additional theoretical details as well as examples of the application of the model to pillared clay
catalysts. This model reports pore widths from 3.8 to 387 angstroms.
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References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
a Pillared Interlayered Clay (PILC) from a Hybrid Density Functional
Theory (DFT) Method,” The Journal of Physical Chemistry B; 2001, 105
(3), 623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded
Clay Catalysts from Hybrid Density Functional Theory (DFT) and
Adsorption Microcalorimetry Methods,” Langmuir 2002, 18, 9816-
9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in
Developing Characterization Methods.” 6th International Symposium on
the Characterization of Porous Solids, Studies in Surface Science and
Catalysis 144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory
Method,”Microporous and Mesoporous Materials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isotherms were calculated using the non-local prescription of Tarazona, employing
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free surface
Substrate: Any
Category: Surface energy
Method: Argon at 87K

This model was produced in the same manner as the N2 Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.

N2 - Tarazona NLDFT, Esf = 30.0K

Models Based on Statistical Thermodynamics
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Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for
a silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. These models are slightly different from N2-DFT
and Ar-DFT models that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio
of 6.

This model is particularly useful for microporous carbon materials. The reported pore size range is
from 3.5 to 250 angstroms.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the same methods and assumptions that were used in the
model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electron microscopy (HRTEM) and/or
X-ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Models Based on Statistical Thermodynamics
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the graphitic surface of an
infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported
pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and multiple concentric graphitic
surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.
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This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

Models Based on Statistical Thermodynamics
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MODELS BASED ON CLASSICAL THEORIES
Both surface energy distribution and pore size distribution may be evaluated using classical
approaches to model kernel functions for use with equation (1) of the DFT Theory. The
Calculations document can be found on the Micromeritics web page (www.Micromeritics.com). Be
aware that the deconvolution method only provides a fitting mechanism; it does not overcome any
inherent shortcomings in the underlying theory.

SURFACE ENERGY
The use of classical theories to extract adsorptive potential distribution is mostly of historical
interest. At a minimum, the equation must contain a parameter dependent on adsorption energy
and another dependent on monolayer capacity or surface area. This is sufficient to permit the
calculation of the set of model isotherms that is used to create a library model. The Langmuir
equation has been used in the past, as have the Hill-de Boer equation and the Fowler-
Guggenheim equation. All of these suffer from the fact that they only describe monolayer
adsorption, whereas the data may include contributions frommultilayer formation.

PORE SIZE
It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure,
this knowledge can be used to characterize the mesopore size distribution of the adsorbent. The
correlating function most commonly used is the Kelvin equation. Refinements make allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the
pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data
using Kelvin-based theories, such as the BJH method, were for the most part developed decades
ago and were designed for hand computation using relatively few experimental points. In general,
these methods visualize the incremental decomposition of an experimental isotherm, starting at
the highest relative pressure or pore size. At each step, the quantity of adsorptive involved is
divided between pore emptying and film thinning processes and exactly is accounted for. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore
sizes. If the thickness curve used is too steep, it finally will predict a larger increment of adsorptive
for a given pressure increment than is actually observed; since a negative pore volume is non-
physical, the algorithm must stop. Conversely, if the thickness curve used underestimates film
thinning, accumulated error results in the calculation of an overly large volume of (possibly
nonexistent) small pores.
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The use of equation (1) represents an improvement over the traditional algorithm. Kernel
functions corresponding to various classical Kelvin-based methods have been calculated for
differing geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average

Models Based on Classical Theories
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B DFT Models

Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887g cm-3

N2 - Broekhoff-de Boer Model
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Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the Inter-
national Symposium on Surface Area Determination, D.H. Everett, R.H.
Ottwill, eds., U.K. (1969).

DFT MODEL REFERENCES
The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, Micro-
meritics Instrument Corp; presented at the International Symposium on the Effects of Sur-
face Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July
1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,”
Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier
Science Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated
by Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference
on the Fundamentals of Adsorption, Pacific Grove, CA (1995).

DFT Model References
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C EXPORTED DATA EXAMPLE
This exported data has been truncated for this manual.

Sample Information

                    Sample:    Carbon Black ASTM SRB C7  

                  Operator:    AWT                       

                 Submitter:    Micromeritics             

                 Mass type:    Entered                   

               Sample mass:    0.2388 g                  

                   Density:    1.900 g/cm³               

              Type of data:    Automatically collected   

           Instrument type:    2390                      

  Original instrument type:    2390                      

                  Comments:                              

Degas Conditions

  Degas conditions:    Degas Conditions  

            Smart VacPrep evacuation

     Backfill sample tube:    Automatic         

          Evacuation rate:    0.67 kPa/s        

  Unrest. evacuation from:    0.67 kPa          

             Vacuum level:    1.333224e-03 kPa  

C Exported Data Example
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C Exported Data Example

          Evacuation time:    0 min             

    Temperature ramp rate:    1.0 °C/min        

       Target temperature:    30 °C             

            Hold pressure:    13.3 kPa          

                Heating Phase

  Sample                     Ramp             

  prep:     Temperature      Rate      Time   

  Stage   (°C)  (°C/min)    (min)  

----

       1             20          10       10  

       2            300          20       60  

Analysis Conditions

  Analysis conditions:    Carbon Run Conditions  

              Pressure Table

   Starting      Pressure       Ending     

   Pressure      Increment     Pressure    

(p/p°)        (p/p°)        (p/p°)     

---

  0.000000000                 0.050000000  

  0.050000000                 0.075000000  

  0.075000000                 0.100000000  

  0.100000000                 0.125000000  

  0.125000000                 0.150000000  
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  0.150000000                 0.175000000  

  0.175000000                 0.200000000  

  0.200000000                 0.225000000  

  0.225000000                 0.250000000  

  0.250000000                 0.275000000  

  0.275000000                 0.300000000  

  0.300000000                 0.325000000  

  0.325000000                 0.350000000  

  0.350000000                 0.375000000  

  0.375000000                 0.400000000  

  0.400000000                 0.425000000  

  0.425000000                 0.450000000  

  0.450000000                 0.475000000  

  0.475000000                 0.500000000  

  0.500000000                 0.525000000  

  0.525000000                 0.550000000  

  0.550000000                 0.575000000  

  0.575000000                 0.600000000  

  0.600000000                 0.625000000  

  0.625000000                 0.650000000  

  0.650000000                 0.675000000  

  0.675000000                 0.700000000  

  0.700000000                 0.725000000  

  0.725000000                 0.750000000  

  0.750000000                 0.762500000  

  0.762500000                 0.775000000  

  0.775000000                 0.787500000  

  0.787500000                 0.800000000  

  0.800000000                 0.812500000  

  0.812500000                 0.825000000  

  0.825000000                 0.837500000  

  0.837500000                 0.850000000  

C Exported Data Example
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C Exported Data Example

  0.850000000                 0.862500000  

  0.862500000                 0.875000000  

  0.875000000                 0.887500000  

  0.887500000                 0.900000000  

  0.900000000                 0.910000000  

  0.910000000                 0.920000000  

  0.920000000                 0.930000000  

  0.930000000                 0.940000000  

  0.940000000                 0.950000000  

  0.950000000                 0.960000000  

  0.960000000                 0.970000000  

  0.970000000                 0.980000000  

  0.980000000                 0.990000000  

             Preparation

  Evacuation rate:    40.00 kPa/min  

  Evacuation time:    2.00 min       

    Free Space

  Calculated      

                     p° and Temperature

           p° type:    Measured in Psat tube for each point  

  Temperature type:    Entered                               

       Temperature:    77.150 K                              
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            Analysis Method

       Analysis mode:    Equilibration  

  Equilibration time:        2 s        

Adsorptive Properties

                      Adsorptive:    Nitrogen (N2)  

       Non-condensing adsorptive:    No             

       Maximum manifold pressure:    139.989 kPa    

  Molecular cross-sectional area:    0.162 nm²      

      Adsorbate molecular weight:    28.01          

            Thermal conductivity:    1.00           

             Non-ideality factor:    0.0000620      

       Density conversion factor:    0.0015468      

Report Options

     Report options:    Carbon Black                          

  Show report title:    Yes                                   

       Report title:    Micromeritics Instrument Corporation  

       Show graphic:    Yes                                   

       Graphic file:    miclogo.emf                           

     Graphic height:    0.250 in                              

      Graphic width:    2.000 in                              

C Exported Data Example
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C Exported Data Example

        Summary: Yes

            Surface Area

           Single-point BET:    Yes  

            Multi-point BET:    Yes  

                   Langmuir:    No   

           t-Plot Micropore:    Yes  

            t-Plot External:    Yes  

  BJH Cumulative Adsorption:    Yes  

  BJH Cumulative Desorption:    No   

        D-H Cum. Adsorption:    No   

        D-H Cum. Desorption:    No   

                  Pore Volume

       Adsorption Total:    Yes                

      Relative Pressure:    -1.000000000 p/p°  

       Desorption Total:    No                 

       t-Plot Micropore:    Yes                

    BJH Cum. Adsorption:    Yes                

    BJH Cum. Desorption:    No                 

    D-H Cum. Adsorption:    No                 

    D-H Cum. Desorption:    No                 

            Pore Size

  Average pore diameter:    Yes  

    BJH adsorption avg.:    Yes  

    BJH desorption avg.:    No   

    D-H adsorption avg.:    No   
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    D-H desorption avg.:    No   

            Other

          Freundlich:    No  

              Temkin:    No  

      Alpha-S method:    No  

       DFT Pore Size:    No  

  DFT Surface Energy:    No  

   Nanoparticle Size:    No  

       Horvath-Kawazoe

  Maximum pore volume:    No  

    Median pore width:    No  

      Dubinin-Radushkevich

  Micropore surface area:    No  

      Monolayer capacity:    No  

          Dubinin-Astakhov

     Micropore surface area:    No  

  Limiting micropore volume:    No  

               MP-Method

        Cumulative surface area:    No  

         Cumulative pore volume:    No  

  Average pore hydraulic radius:    No  

C Exported Data Example
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D O-RING COMPATIBILITY
Viton or Buna-N may also be suitable for analyses similar to the reference material example file.
The ability to re-use Buna-N or Viton O-rings may be limited, while the re-use of Kalrez O-rings
should be more broad. Frequency of use and, potentially, several other factors affect the duration
of O-ring use, so rigid rules cannot be specified for these materials. Leak rate and ultimate
vacuum levels may be used as indicators for O-ring performance.

D O-ring Compatibility
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E WORKSHEETS

Worksheets in this section may be copied as needed.

Sample Data Worksheet for Gas Adsorption on the next page

EWorksheets
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EWorksheets

SAMPLE DATA WORKSHEET FOR GAS ADSORPTION

Sample tube identification:

Sample Mass (g)
Before Degas After Degas After Analysis

1. Mass of empty sample tube set g

2. Mass of sample tube set plus sample g g g

3. Mass of sample (step 2 minus step 1) g g g

Degas Information
Degas apparatus
Temperature (°C)
Time (hours)
Actual time started
Actual time finished

Degas Notes:

E - 2 Gemini VII Operator Manual
239-42828-01 (Rev H )—May 2021







filler rod 5 - 3
sample tubes 5 - 3

configuration
unit 2 - 15

contact us iii
control chart report 6 - 5
corporate profile ii
cryogen requirements 1 - 5

D
data, manually enter 3 - 7
degas

samples 5 - 8
dewar

fill and install 5 - 11
precautions 5 - 1, 5 - 1, 5 - 11

Dewar
check 10 - 20
clean 10 - 20

DFT
model references B - 17
models based on classical theories B -

14
models based on statistical ther-

modynamics B - 1
pore size report

options 7 - 12
regularization 7 - 13, 7 - 13

surface energy report options 7 - 14
DFT Models B - 1
diagnostics 8 - 1

clean and verify the gas line 10 - 8
leak test 10 - 15
start test 8 - 1

Dollimore-Heal
plot options 7 - 18
report options 7 - 15
tabular report 7 - 19

Dubinin
pore volume report options 7 - 22
report options 7 - 20
tabular report options 7 - 23
transformed isotherm plot options 7 - 24

INDEX

A
about this manual iv
adsorptive properties

create file 4 - 2
Alpha-S method report 7 - 2
analysis

empty tube 5 - 14, 10 - 17
perform 5 - 1
prepare for 5 - 3
reference material analysis 10 - 17

analysis conditions
degas 4 - 3
parameter file 4 - 3

analyze samples
total surface area of 1.0m2 or less A - 1

analyzer
about 1 - 1
configure 2 - 14
schematic 2 - 17
show status 2 - 20
software 2 - 1

B
balance servo valve

calibration 9 - 2
BJH

plot options 7 - 10
report options 7 - 6
tabular report options 7 - 11

C
calibration 9 - 1

balance servo valve 9 - 2
load from file 9 - 6
match transducers 9 - 3
sample servo valve 9 - 5
save to file 9 - 6

clean
dewar 10 - 20
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Horvath-Kawazoe
plot options 7 - 32
report example 6 - 32
report options 7 - 29
tabular report options 7 - 32

I
instrument exterior, clean 10 - 21
instrument, status 2 - 16
intended use vi
interactive reports 6 - 10
Isotherm Linear Plot Report 6 - 33
isotherm report option 7 - 33

L
Langmuir

report option 7 - 35
leaks

perform test 10 - 15
libraries 2 - 11
list files 2 - 21
log

show instrument 2 - 16

M
maintenance

clean and verify the gas line 10 - 8
clean instrument exterior 10 - 21
connect gas cylinder 10 - 12
disconnect gas cylinder 10 - 11
guidelines for connecting gases 10 - 6
replacement cylinder 10 - 11
vacuum pump 10 - 26

manual control
enable 10 - 14

manual, about this iv
match transducers, calibration 9 - 3
menu structure 2 - 1
methods, about 2 - 12
MicroActive reports 6 - 11
MP-Method

plot report options 7 - 39

E
EFUP vii
elevator, lubricate drive assembly 10 - 21
empty tube

analysis 5 - 14, 10 - 17
environmentally friendly use period vii
equipment options and upgrades 1 - 3
evaluate report results 6 - 12
export files 2 - 21
exported data example C - 1

F
f-Ratio method report 7 - 25
fields and buttons, common 2 - 2
file status 2 - 5
files

export 2 - 21
list 2 - 21
open a sample file 3 - 5

filler rod, clean 5 - 3
Freundlich report 7 - 27

G
gas

clean and verify the gas line 10 - 8
connect gas cylinder 10 - 12
delivery tubes 10 - 21
disconnect gas cylinder 10 - 11
guidelines for connecting 10 - 6
replacement cylinder 10 - 11
requirements 1 - 5

general safety v
graph

features and shortcuts 6 - 22
generate overlays 6 - 27

H
heat of adsorption report 6 - 8
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report
summary

physical adsorption 7 - 43
report examples

BJH Adsorption 6 - 31
Horvath-Kawazoe 6 - 32
sample log 6 - 34
t-Plot 6 - 35
Validation 6 - 36

report options
selected 7 - 1

reports
about 6 - 1
Alpha-S method 7 - 2
BET surface area 7 - 4
BJH

adsorption/desorption 7 - 6
plot options 7 - 10
tabular report 7 - 11

Control Chart 6 - 5
DFT pore size 7 - 12
DFT surface energy 7 - 14
Dollimore-Heal

adsorption/desorption 7 - 15
plot options 7 - 18
tabular report 7 - 19

Dubinin 7 - 20
pore volume 7 - 22
tabular 7 - 23
transformed isotherm plot 7 - 24

evaluating report results 6 - 12
examples 6 - 31
f-Ratio method 7 - 25
features and shortcuts 6 - 18

graphs 6 - 22
reports 6 - 18

Freundlich 7 - 27
generate sample file overlays 6 - 28
heat of adsorption 6 - 8
Horvath-Kawazoe 7 - 29

plot options 7 - 32
tabular report options 7 - 32

interactive 6 - 10
isotherm 7 - 33
Isotherm Linear Plot 6 - 33
Langmuir 7 - 35
MicroActive 6 - 11

report options 7 - 37
tabular report options 7 - 40

O
O-ring compatibility D - 1
option presentation 2 - 9
options report 7 - 41
overlays

generate 6 - 27
sample file 6 - 28

P
parameter files

about 4 - 1
adsorptive properties 4 - 2
analysis conditions 4 - 3
file name extensions 4 - 1
report options 4 - 9

parts and accessories 10 - 4
plot options

BJH 7 - 10
Dollimore-Heal 7 - 18
Dubinin transformed isotherm 7 - 24
Horvath-Kawazoe 7 - 32
MP-Method 7 - 39

power 10 - 4
power analyzer on and off 10 - 22
power failure, recover from 10 - 26
preventive maintenance 10 - 19
pump

oil-based vacuum pump 10 - 26

Q
QuickStart analysis 5 - 18

R
reference material analysis 5 - 16, 10 - 17
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regression report 6 - 3
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for 21CFR11 2 - 24
setup 2 - 21
updates 2 - 22

software uninstall 2 - 23, 2 - 28
SPC report 6 - 2
specifications 1 - 6
status

analyzer 2 - 20
instrument 2 - 16

summary report
physical adsorption 7 - 43

T
t-Plot

report example 6 - 35
report options 7 - 45
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BJH 7 - 11
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U
unit configuration 2 - 15
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V
vacuum pump
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plot report options 7 - 39
tabular report options 7 - 40
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start 6 - 1
t-Plot report options 7 - 45
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S
safe servicing 10 - 5
sample

degas 5 - 8
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perform 5 - 12

sample audit trail report 7 - 42
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sample file 3 - 2

about 3 - 1
open 3 - 5
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sample log
report 7 - 42

sample log report example 6 - 34
sample servo

valve calibration 9 - 5
sample tube

clean and label 5 - 3
install 5 - 9
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